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I/O Features 

2 expanders max, no limitations on using them (like the CDL3 had) 

Race Logging Kit: 

• 10Hz GPS 

• Two button loom 

• Network Cable 

• Terminated race loom 
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Standard 250MB 

30 I/O standard 44 optional 

T2 Upgrade available 
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Open the correct Dash Manager for the Display you have. 

Locale File 

After installing Dash Manager software, the first time the software is run a dialogue will 
appear asking you what ‘locale’ file you want to use, with a choice of: 

• All channels metric 

• Common channels in PSI, F, MPH, In 

• Common channels in PSI 

• Drag Racing 

By default all channels in the Dash are treated as Metric. While it is possible to change the 
units used for any particular channel by using the ‘Edit channel’ feature, the locale file offers 
a way to change the units for a large group of commonly used channels and select the one 
most appropriate to your application. The selection can be changed at a later date by going 
to ‘Tools – Options’ and selecting a different locale file. 

Click on File>New and then either select Blank to start from scratch or select the ECU you are 
using. In this case I will be connected to an M1. 

Click on File>Save and call the config an appropriate name. It’s always good to include either 
dates or version numbers so changes can be easily tracked. 

Files are by default saved to ‘user’\document\MoTeC\Dash\Config 
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Click on File>Open to display a window listing all previously saved configs. 

If you have a config created with an older version of Dash Manager you can import it using 
the import button. 

You can also select compatible Dash configurations, in this case you can import a C125 config 
to create a C127 config. C185 to C187 is also possible. 
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This is where all of the physical inputs and outputs are setup, as well as expanders if 
available. 

When using the M1 setup, a number of inputs are preconfigured for display control such as 
the mode button/alarm acknowledge and brightness adjustment. 
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To select a channel, either double click the input line or highlight it and click channel. 

We are going to set up a front brake pressure sensor on AV1. Start typing in the search bar 
until ‘Brake Pressure Front’ is displayed. Either double click it or highlight it and press OK. 
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Editing Channel Details 

In the channel selection window click Edit. This will allow you to change the name of the 
channel and its displayed unit.  

It is important to note the base resolution of the channel cannot be changed. All calculations 
within the Dash are done in the base unit of the channel and then are converted afterwards 
to the display unit. This is especially important when configuring CAN templates or using 
Advanced Maths. 

As an example, let’s say you have have an M800 that is set to use PSI for Engine Oil Pressure 
which you want to display on your C127 in PSI. The base resolution of Engine Oil Pressure in 
the ECU will be 0.1PSI and it will be 0.1kPa in the Dash.   

So in the CAN setup you have to convert from 0.1PSI to 0.1kPa. 

0.1PSI = 0.6895kPa 

The Dash only uses whole numbers in the communications setup so you have to multiply the 
input channel by 6895 and then divide by 1000 

0.1*6895/1000=0.6895 

Now the Dash will have the correct channel value and will convert it to the selected 
displayed units in the background. 
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There are two ways to calibrate the input, either with an existing calibration file or manually. 

To load an existing calibration click on load Cal: 

In the search box begin typing until the file you want is visible. 

Either double click it or highlight and click OK. 
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Manual Calibration 

There are two ways to insert values. You can either go through each position on the table if 
you have a data sheet from the sensor manufacturer, or in this case where we are calibrating 
a steering potentiometer, you can use the read value button.  

Point the steering wheel straight ahead, click read value and then enter 0 deg in the adjacent 
box. 

Turn the wheel 90 deg to the left, click read value and enter -90 deg. Repeat for 90 deg to 
the right from centre. 

This sensor is rotary pot with a 5V supply so the method needs to be set to Ratiometric (5V). 

Absolute voltage is used when the sensor has its own internal regulation and its output 
voltage is not proportional to its input voltage. 
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Communications Setup 

This is where all CAN/Serial communications are set up to communicate with any other 
device. 

As we started an M1 config, the comms templates are already loaded for the channels that 
are sent out of the M1 with a GPA/GPR Package. 

CAN rate can be set to a number of different values, MoTeC devices default to 1M, some can 
be changed others are fixed. Typically vehicle factory CAN buses will be at 500k, heavy 
vehicles (J1939) at 250k. All devices on the CAN bus must be at the same rate otherwise they 
will not work. 

Some of the CAN buses can be repurposed as additional serial ports if necessary by changing 
the mode in the drop down menu. 
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We want to add an HD-VCS camera to our comms setup. To do this, click Select and in the 
search bar start typing HD-VCS until the template comes up. Click OK and it is set up, ready 
to go. 

The next thing to do is set up the video synchronisation messaging. Click on the Video 
Capture tab and tick the ‘Send Video Synchronisation Messages’ box. Select the correct CAN 
bus from the drop down menu and click OK. 
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The Aux outputs are open collector and driven to ground. They have a max current of 0.5A 
so are only suitable to directly control small loads. Solid state relays are required when 
controlling higher current devices. 
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Electrical Specifications 

The Auxiliary Outputs switch to ground and may drive up to 0.5 Amps. 

On/Off Output: 

• Fuel Pump 

• Shift Light 

• Thermo Fan 

Duty Cycle 

• Boost Control 

Frequency 

• Tachometer 
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A device is normally continuously powered. The Dash output is switched to ground to turn 
the device 'on'. 

Frequency:  Number of complete cycles in one second, measured in Hertz.   
1 Hz = 1 cycle/second. 

Cycle: Time from when a device is turned 'on' until the next time it is turned 'on'.  

Pulse Width: The time in seconds the device is 'on'. 

Duty Cycle: Percentage of time the device is 'on' in one cycle. 
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Each digital output can be controlled in one of several modes: 

On/Off only output available in an older SDL. 

Light: If the light is on, it is driven with a programmable duty cycle to vary its intensity 

Frequency: the output is driven at a programmable frequency (Note: 22Hz minimum) 

Duty Cycle: the output is driven at a programmable duty cycle 

Frequency and Duty Cycle: Both the Frequency and Duty Cycle of the output can be varied 
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Beacon Types 

GPS: Uses a connected GPS unit and GPS coordinates of the start/finish line to trigger the 
start/end of lap. The detection radius is used to ensure that the lap is triggered whether you 
are on the far right or far left of the track. Also accounts for drift. The beacon triggers when 
the vehicle passes at 90 degrees to the start/finish location, so making the detection radius 
larger should have no effect on the accuracy of the timing. Only the drift will cause 
inaccuracy. Coordinates set the location of the start finish line. This is tied to the venue file. 

Button/Internally Generated: Can set up a switch to trigger the beacon or internal maths 
calculation on other conditions . Can simply be an on/off signal sent from another device on 
CAN. 

BR2: CAN signal from a MoTeC BR2 module. Need to add CAN template to correct CAN bus 
and set the Mode and ID to match beacon. Can specify an ignore time; beacon will not be 
triggered within this time period even if a beacon signal is received. 
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Ground Speed Tab 

Calculates vehicle Ground Speed from either the left or right wheel speed, or from one of a 
number of methods that help to avoid wheel lockups giving incorrect readings. Correction of 
wheel lockups is particularly important for the Lap Distance calculation which is derived from 
the Ground Speed. 

Method 

Specifies the method for calculating the Ground Speed. 

• Left - Uses the Left wheel speed channel. 

• Right - Uses the Right wheel speed channel. 

• Fastest - Uses the fastest of the two wheel speeds to avoid errors due to wheel lock. 

• Average - Uses the average of the two wheel speeds until the difference between the two 
exceeds a limit value, at which point the fastest of the two wheel speeds is used to avoid 
errors due to wheel lock. 

• 4 Wheel (ABS) - Uses the fastest of up to four wheel speeds, including the wheel speeds 
defined in the drive speed calculation. 

G Correction 

G Correction is used to correct for wheel lockups during braking. It predicts the wheel speed 
during braking using the Longitudinal G Force sensor to detect and correct wheel lockups. 

This can be used when only one wheel speed sensor is allowed. It may also be used when 
measuring more than one wheel speed, which is particularly useful for ABS systems; they 
tend to have erratic wheels speeds as the wheels partially lock during ABS activation. 
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Representative lap distance is important for a number of calculations, so it is useful to set 
other conditions that will reset lap distance for when the vehicle enters the pits or misses a 
beacon. 

Beacon correction uses the lap length set in the venue file. 
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Requires Speed, RPM or Gear sensor 

Requires ratios of gearbox in details 

MUST be updated each time a different tyre or gear ratio is used.  

1. The Output Channel ‘Gear’ is selected. 

2. The acceptance delay applies a filter, otherwise (especially for speed/RPM method) the 
fluctuations in RPM during the change will cause it to attempt to show more than one gear. 

3. The method can be either derived from speed and an RPM signal or purely from a sensor. 

4. If the details are entered (as shown on previous page) for the ratios and the correct 
circumference of the tyre is entered, pressing the Calculate button will update the 
speed/RPM ranges for the Dash. 

5. A dialog appears asking the user to confirm the details – pressing on Calculate (again) then 
updates the information in the Gear Detection screen. 

The Gear Detection often causes the most problems as people forget that each time a tyre is 
changed and ratios are changed the Dash must be updated and the NEW configuration sent 
to the Dash – assuming gear is being calculated from speed/RPM and not directly from a 
voltage sensor. 

Gear will only be displayed if: 

• The correct tyre size is entered (correct wheel speed calibration) 

• The correct Ratios are entered in the details editor [File Menu] [Edit details] Gears Tab 

• You have gone to the gear detection page and clicked [Calculate] 
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The Dash can calculate fuel consumption figures using either a channel from an ECU, or from 
a fuel level sensor. There are three calculation methods, each slightly different with 
‘Incrementing Fuel Used Value’ being the most common and widely supported by different 
ECUs. 

MoTeC ECUs transmit Fuel Used (RAW) in 10ml units, e.g. a value of 15 on the input channel 
corresponds to 150ml. As the calculation is done in mls, this means that the RAW Fuel Used 
value must be multiplied by 10, giving a scaling of (+0)*10/1 

The Fuel Used value is stored in permanent memory so that if the Dash power is removed, 
the Fuel Used value is maintained at next power on. If the fuel used figure stops updating for 
4 seconds and it has been at least 10 minutes since it was last saved, then it will be saved. 
RPM is not used in determining when to save the fuel used. 

The Fuel Used is only zeroed when the reset condition becomes true. 

Check the boxes under the other tabs to select the channels you wish to have calculated, e.g. 
Fuel Used per Lap, Fuel Remaining. 

Fuel Usage is the fuel flow rate. 
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The tables are a good way of converting channels. In this case we have Inlet Manifold 
Pressure but we want to be able to display Boost Pressure. The 2D table allows us to convert 
from one to the other. 

Another example is Steering Position. If you have steering wheel position sensor and want to 
convert to actual steered angle you can use a 2D table.  
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Populate Table 

In this example, the Brake Bias channel is calculated from Front and Rear Brake Pressure. 
When front brake has a high pressure value and rear brake pressure has a low value, then 
the output of the table will indicate more front brake bias. 

The tables (both 2D and 3D) linearly extrapolate between points and off both ends. The 
graph shown used a number of additional data points. 
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The example above shows the setup for a channel that will be used for controlling a thermo 
fan.  

Conditions are used for many purposes throughout the setup of the Dash. This function 
allows you to set up a single comparison or combinations of comparisons to generate an 
On/Off (True/False) output channel. These can then be fed into other parts of the config, for 
example to control an output, or start a timer. Especially useful if the same condition is used 
more than once – saves defining it again. They are also useful for setting a smart display. 
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• Data Logging is used to record quantitative data (facts) about vehicle performance (drive 
train and chassis). 

• Monitor the drive train in all parts of a lap to look for unusual changes 

• Confirm ‘gut feel’ and driver feedback about what is happening in the vehicle 

• Sampling rate is determined by the sensor being logged - must log fast enough to record 
important data variations 

• Maximise information available in a test session. Data logging will record everything that 
happens.  

• Data can be used for future setups and as comparison with other drivers. 

• Help diagnose faults and optimise performance, e.g. check fuel and oil pressure are stable 
during the session - no surges. 

• Overlay speeds before and after a chassis change 

• Measure oversteer/understeer at individual corners for planning chassis adjustments 

• Measure braking ability of vehicle (and driver) 

• Compare all elements of a lap against a Reference Lap to understand chassis changes, 
driver technique, tyre performance etc. 
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The available logging time is displayed based on memory size, and as you add channels or 
change the logging rate for a channel, the logging time is updated automatically. 

The Dash Manager software performs an estimation of how long the memory will last based 
on the actual logging rates you have defined. This calculation is displayed in the logging 
screen instantaneously as the changes are made. 
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By highlighting a channel and then clicking on the ‘Rate’ button, the logging rate may be 
individually set for each channel between 1 to 500 times per second (1000Hz for 
C185/C127). 

Some of the channels are marked with an ‘F’ to indicate that they are filtered by an anti-
aliasing technique. 

Channels are sampled at their maximum rate and then averaged to match the chosen 
logging rate. 
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The Start/Stop conditions are used to determine when the display is actually logging data. 
Any channel and multiple conditions can be used to set when the logging starts and stops. 

 The stop condition overrides the start condition, so if a stop condition is true then the 
logging will stop irrespective of the start condition. 
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Useful for diagnostic purposes.  

Using ‘Logging Running’ in a start logging condition is a good way of starting logging as soon 
as the Dash is powered up, i.e. ‘Logging Running’ = False for 0.5sec will start the logging 
straight away and, as long as you don’t have a stop condition, it will continue until the power 
is turned off. 
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Fixed layout, similar setup to previous Dashes. Set positions for channels, channels can be 
selected. 

Three individually configurable pages, with selectable styles. 
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Three pages with different colours/layouts/channels. Switch between them with a button. 
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Changing the displayed units in the Display Setup does not change it in the logging. 

Take note of the number of decimal places and the maximum value that can be displayed. If 
a larger number is required the resolution will need to be reduced. 

Filter: Helpful for channels that are updated very quickly, allows you to actually read the 
value without it jumping up and down by small amounts all the time. 250 milliseconds is 
usually enough. 
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Let’s say we have a rotary switch set up in the M1 to set the boost level. Every time the dial 
is rotated the value boost aim will be displayed. 
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This is where we set up the channels that control the toggling of the pages and which of the 
bottom lines is displayed. There are also output channels to indicate which page and what 
bottom line is displayed. 
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The backlight brightness can be controlled in a number of ways, either by a percentage 
channel, a fixed set brightness or two levels that are switched between via a switch such as a 
headlight switch. 
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If Display Creator is being used instead of the fixed layout then we can also configure it from 
here. Change the display type to an ‘Internal Display’ (using Display Creator) as shown. 

It is also possible to add a setup here if you have an additional D-Series Dash that you want 
to configure with a fixed layout. 
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Each of the channels you want to use in your Display Creator project needs to be added 
here. Think of the Logger and the Display as two separate devices. This sets up the transmit 
template and creates a DBC file that can then be loaded into Display Creator as the receive 
template. 
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Display Page: Number used in conditions to control which page is displayed. 

Number of Pages: Number of pages you will be using in your Display Creator project. 
Note the first number is zero, so for 3 pages Display Page has a range of 0-2. 

Page Up Button: Channel used to increment Display Page by one 

Page Down Button: Channel used to decrement Display Page by one 

Page Reset Button: Channel used to reset Display Page to zero 

Preserve Page: If ticked will save the value of Display Page when the display is turned off. 
Whatever page the Display was on before powering off will be displayed on power on. 
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DBC file name: Generally easiest to leave as the default name. 

When a Display is set up to use Display Creator it will create a DBC file to be imported into 
your DC project. This is all of the communications information required for the channels you 
select to send to the Display. 
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Alarms allows us to create a warning based on certain conditions. In this case we are 
creating an engine temp alarm. When the coolant temperature exceeds 100 degrees celcius 
for 1 second the alarm will be triggered. 

We are also able to modify the value once it has been triggered. In this case, if the coolant 
temperature exceeds 100 degC the alarm comes on. Once this is cleared it will now have to 
exceed 105 degC to trigger the alarm. 

A message needs to be added and will be displayed at the bottom of the screen when an 
alarm is active. The current value of the channel can also be set to be displayed. 

It can be set to automatically acknowledge the alarm after a set period of time and an on 
delay can be set. An output channel can be set for each individual alarm to allow display of 
specific alarms, such as on a SLM. 
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Shift Light Setup 

The Shift lights are set up by a two stage process. The menu is accessed from Functions then 
Shift Lights as shown above in the first picture.  

Next choose which channel drives the lights. This is most likely to be RPM, however, if you 
wish to have the lights as a boost gauge for testing a turbo engine or inline G for 
deceleration, then this channel could also be assigned a channel for a light. (Not in the Shift 
Light setup, however.) 

Try to remember to put the RPM signal lower than the actual RPMyou wish to shift at. 

Why? The main reason is the driver will always need to see the light before he knows to 
change gear. If you want to shift at 6700 RPM for example the light should come on 100 
RPM less (more for a new driver) 

Hysteresis is to stop potential ‘flickering’ of the shift light if RPM is around the shift point. 

The shift lights can also be set to Gear Dependant. This requires a Gear signal from either the 
gearbox, or can be calculated by using Speed and RPM. The gear channel must first be set up 
under ‘Calculations – Gear Detection’. Using a Gear channel, the RPM that triggers the shift 
lights can be modified for the higher gears. 
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SLM is a CAN communications-based shift light with eight individual LEDs that can each emit 
eight different colours at user defined brightness. The lights can be driven by the Up Shift 
Light channels, as well as the Warning Light channel or any others. 

When used with a Dash, the SLM can be configured as a four stage shift light as well as 
having patterns based on up to four User Condition channels and a Warning Alarm option. 
The number of lights, and the colour and brightness for each, can be individually set for each 
display configuration. 

The ability to pick individual items out of status groups and error groups. It is also possible to 
have a light flash, as well as changing between two colours when active; each colour is up to 
the user. 

The ability to have certain colours displayed when any condition is false is also available as 
an alternative to simply having the lights ‘off’ when nothing is triggering them.  

Patterns are arranged in priority order, with the top of the list having the highest priority. 
This means that if a pattern has a high priority, e.g. Warning Lights, it cannot be affected by 
another pattern condition lower in the list becoming true. 

Use of SLM over CAN will free up Aux Outputs to be used for other functions. 
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The details can be filled out either before sending the configuration or when downloading 
the data. This is often overlooked but is very important when trying to identify data later on. 
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Clicking on the Manage Venues button for the first time will bring up a window to 
automatically import venue files. 

Additional tracks can be added manually using either the import button to bring in tracks 
that have already been setup by MoTeC or by clicking Add and filling in all of the details 
manually. 

Every track in the Venue Manager is loaded into the display, meaning that if you have GPS 
beacons set up you can turn up to any of those tracks and get lap times without having to 
change the config. 
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• Vehicle Number and Dash Serial Number: These are the parameters the Dash looks for 
when sending or retrieving configs or data from the Dash. It will match up this page with 
the Dash serial number. If you wish to upload and download on multiple computers, this 
information should match and be on all computers used. 

• Description: Usually the style of vehicle, e.g. Formula Ford or V8 Superboats 

• Engine ID: If you are running a sealed engine, log the serial number and the install date. 
Most people ignore it and when they come to talk with their supplier they have forgotten 
these details. 

• Weight/Fuel Tank etc:  Useful for when you’re back in the office and forgot what run 23 
Friday afternoon was. Also note the units can be metric or imperial. 100 gallons will not 
fit in a 100 litre fuel tank. 

• Driver: This will be displayed in i2 as the name along with the log file. Leaving it blank 
may save time but wastes valuable post processing time matching your laps up to the 
official timing and scoring sheet to work out who was driving. 

• Comments section: This will be added to the Log file. It’s your main hope of remembering 
which run was with fresh tyres, different springs etc.  

• Track: Used by i2 for its Vehicle Roll calculation 

• Wheelbase: Used by i2 for its Oversteer calculation 

• Fuel Tank Capacity is used for Fuel Remaining calculations 

• Gear Ratios: For the record and used if calculating Gear from Speed and RPM. 

Most of the errors in missed details on laptops etc. come from users not having the details 
for the car they download on their computer. 
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All of the Colour Display Loggers (C-Series) use Ethernet to communicate with the PC.  

The Display-only devices (D-Series) require a CAN connection. 

• Add a new connection, click Add. 

• Either enter the serial number directly or click search. If using search it will list all 
connected devices. 

• Double click or highlight and click Select on the device with which you want to connect. 

• If you have more than one device in your available connections, highlight the one you 
want to connect to and click ‘Make Active’. There will be a green tick next to the active 
one. 
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• Send/Retrieve Configs 

• Get Logged Data  

• Real time viewing of sensors 

• Zero Sensors 

• Simulate conditions with engine/vehicle off  

• Enable options in the Dash 

• Upgrade the firmware in the field 

• Test inputs/outputs, raw voltages/diagnostics 

• Send Reference Laps  

• View History Logs 
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Clicking on Get Logged Data or pressing F8 will download the data from the logger (if the 
upgrade is enabled). Once the data is retrieved it will ask if you want to clear the logging 
from the device. 
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Vehicle details: When the download is complete you will be asked to fill out details about 
the logged data. It is important to put in as much information as possible to allow easy 
search at a later date. It is very difficult to find a specific log file months later if these details 
are not filled in correctly. 

Log file location can be edited in the Manage Venues window. 
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The DBC file must match the Dash Manager Configuration loaded into the Display. 
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This is a list of all of the channels in the dbc file created by Dash Manager.  

It is possible to untick channels that are not needed in the Display setup, which is usually 
more useful when importing a dbc file from an external source in which there are a number 
of channels that you don’t require to be displayed. 
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When using a dbc file created by Dash Manager, if the Display setup is modified and the dbc 
file is changed, DC will automatically notify you that changes have been made to a linked dbc 
file. 
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Each of the input signals need to be assigned to a channel in Display Creator. There are two 
methods of doing this, the first is create all of the channels and link them to the input signals. 
The second is to create both the channel and link to the signal when creating the display 
element. 
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Click the ‘Add New Channel’ button to create a new channel. 
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Once you have created a new channel, make sure it is selected and click Connect to Signal. 

 Select a signal from the DBC file to link it to the new channel. The name, data type, quantity 
and unit are all updated to match the signal automatically. 
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It is important to check the units; this will default to the base units sent by the Dash. In the 
case of Engine Speed this is Hz, or rev/sec, which is almost of no use so should be changed to 
RPM. 

Minimum and Maximum are useful when using the simulate function but otherwise do not 
affect the actual functionality of the channel when used in a Display. 
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The first thing we want is a tacho. We create a new dial gauge and select ‘Engine Speed’ as 
the channel. 

The start/finish angles for the gauge can be set; the number of divisions and the text that is 
displayed can all be configured from this window. 
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0 degrees is top centre. Positive is clockwise to bottom centre and negative is anti-clockwise 
to bottom centre. The Minor and Major divisions set the number of tick marks on the dial.  

The text is what is actually displayed on the dial. We want the tacho to show 0-9 rather than 
0-9000 so we make the change in this section. 



Copyright MoTeC 2015     Page 85 

We now need to position and size the dial correctly. We want to reduce the size slightly to 
allow room for additional channels and we want it centred on the page.  
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The dial can be changed from the default to any custom image. There are a number of 
preloaded images that can be selected from the library tab or your own image can be loaded 
by clicking on Import. 
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To give the dial gauge a more defined edge we will add some images. Again we can select 
from a number of preloaded images or import our own. In this case we will use a preload 
image. The sizing and positioning need to be adjusted to fit our gauge; this is done in the 
same way as positioning the dial gauge. 
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The preloaded image isn’t quite what we wanted ; we want to hide the inner rings and insert 
our own. To do this we create an oval that will cover the rings, allowing us to put our own 
over the top.  

Remove the border, change the fill to solid and the colour to black. We now centre the oval 
and resize it to cover the rings. The Z-Order needs to be correct so that the inner rings are 
covered but the dial numbers are not. 
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We can import our own images in two ways, the first is in the ‘Images’ tab. Click on the 
‘Import’ button, browse to the location of the image you want to import and click ok. 

The image will now be selectable from the image insertion window. 
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The second method is to click the ‘Import’ button from the Insert image window. 
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Positioning and sizing the image is done in the same way as all other elements. In this case 
we want to decrease the opacity so that you get more of a glowing effect. 

It is also important to ensure the images are in the right order. You can click and drag the 
image above or below the dial gauge. The higher up the list, the further ‘forward’ the 
element is.  
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We now want to add a number of numerical channels and text labels to display the rest of 
our channels. Once we have a text element and a channel value we want to align them 
correctly. 

To align two objects, select the them both either by left clicking and dragging the selection 
window over both of them, or by holding control and clicking on them individually. 

Once selected, right click on one of the objects, highlight ‘alignment’ and then select Top. 
The two objects will now be aligned at the top. 

Note: the object that is selected first becomes the reference, all other objects will move to 
align with it. 
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We want this channel to be ‘Coolant Temperature’ so we select it from the drop down box.  

It is often useful to reduce the refresh rate for channels that update very quickly to make it 
easier for the driver to read. This is not usually the case for temperature channels so we will 
leave this as the default. 
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The easiest way to replicate a number of channels is to copy the text and channel value 
multiple times to quickly set out where you want your channels displayed. Then go through 
each of them, change the text and link to the correct channels. 
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We have decided that we want to display ‘Oil Pressure’, so we will need to add it to the Dash 
configuration as it is not currently configured. 
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In Dash Manager we add ‘Engine Oil Pressure’ to the Display setup. Once the configuration is 
saved, we get the DBC file update message in Display Creator. 

Click update to add the new channel. 
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The second method of adding a channel is to do it in the ‘Pages’ tab. To do this, either select 
‘Create New’ in the channel selection drop down or click the icon next to the drop down and 
then select ‘New’.  
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To create a new channel simply tick the ‘Connect to a signal or bit decode’ check button and 
select the signal. The name and channel properties will be populated automatically. 
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It is often a good idea to use groups to collect together parts of the project. For instance all 
of the images and the dial gauge can be grouped together making it easier to find/edit 
individual parts. 
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With everything grouped you can open a group and only see the individual parts for a 
particular element. It also allows you to hide a group and all of the elements within for 
testing purposes. 
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We also want to add a ‘Gear’ channel. The same method is used as the other channel values. 
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Enumerators are a way of giving a text value to a state channel. For instance, in this case 
when we receive 0 and -1 from the Dash for gear position we actually want N and R to be 
displayed. 
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Any value that doesn’t have an enumerator specified will be displayed as the raw value. In 
this case, with gear, we only need to specify -1 and 0 as we want forward gears to be 
displayed as they come from the Dash, i.e. 1, 2, 3 etc. 
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Changing the data type to Gear Display will now display the text specified in your gear 
display enumerator. 

Can be used for any state channel that you want to display text. For instance, if you wanted 
to display the ‘Engine Reference Speed State’ channel, each of the values 0-11 can have a 
text description allocated to them. So instead of displaying the integer value you get a 
meaningful tag such as ‘Cycle Lock’.  
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Switches allow you to switch between multiple objects with the use of conditions. 

For example, we want the gear indicator to be red when it is in Neutral or Reverse and white 
when in any of the forward gears. 
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Put the new switch into the ‘Gear’ group to keep things tidy. Now create two new switch 
groups by right clicking on the switch. 
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Each of the switch groups can have a number of conditions based on any channel in the 
configuration. Any number of groups can be added to a switch. 

The switch group will only be displayed if the condition is true, otherwise it will be blank. The 
easiest way is to have one of the groups with no condition, that way it will always be 
displayed if the other switch conditions aren’t true. 
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Add additional conditions and then edit the logic operators. In this case we want an ‘or’ 
operator but if we wanted an ‘and’, you simply double click on the logic operator and then 
change it from the drop down menu.  

The conditions can be nested to allow for multiple and/or operators.  
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A switch group with no condition becomes the default. This group will be displayed when 
none of the other group conditions are true. 
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Alarm 1 is automatically added and is controlled by the alarm setup in Dash Manager. It will 
also display the text and value of channels that are defined in the alarm setup of Dash 
Manager. 

Any number of additional alarms can be added for various conditions. 
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An alarm can be set up with multiple conditions. In this case we have an ‘Oil Pressure Low’ 
alarm that is active when the oil pressure is below 200 kPa and the engine speed is above 
4000 RPM. 

On and off delays can be set for each condition to stop transient behaviour triggering an 
alarm or the alarm turning off before the driver notices. 
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The new alarm ‘Oil Pressure Low’ is automatically added to alarm display list. 

What is displayed when the alarm is active can be modified just like any other object on the 
other pages. 
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Conditions are useful when we want to use the same conditions multiple times. This way if 
anything changes you only have to update one condition. 

Can be set as Momentary, Toggle or Set/Reset depending on how you want it to function. 
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These two conditions will be used in a switch based on Engine Speed. 
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The condition functions are used in the switch groups rather than directly putting in the logic 
functions. This means that if we have a number of pages with the same conditions and you 
want to modify them you only have to do it in one location rather than every page. 

Take note of the order of the switches groups. The red ring needs to be higher up the order 
because when it is active, i.e. greater than 7000 RPM, the yellow ring is also active (greater 
than 6000). If the orange switch is higher up, the red one will never be displayed. 

Only the first switch group can have no condition. 
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Sending a DC config is a similar process to sending a Dash config. You select the device from 
the drop down menu and then click ‘Check & Send’. 

It is possible to store a copy of the project on the device so it can be retrieved later. 

The device can be set up to require a password to send a configuration to stop unwanted 
changes. 
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Display Creator has a number of pre-configured display pages that can be selected. These 
include the default display pages that come with the Colour Displays, allowing customisation 
without having to build an entire Display from scratch. 

Elements or entire pages can be copied from any of the pre-configured projects into your 
own custom project. 
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Now that we have a base to start from we add the dbc file from our Dash config in the same 
way as previously discussed. 
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We now start by selecting the text label and renaming it to the channel we want to display in 
that position. 
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Select the channel you want to allocate, the yellow warning symbol lets you know the 
allocated channel can’t be found. The preconfigured projects all contain channel place 
holders that need to be reallocated with the channels you actually want displayed. 
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Select the signal you actually want to be displayed and click OK. It will automatically create 
the channel and fill out the parameters. 
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Continue through and allocate each of the channels you want displayed. 

It is important to note that only one channel can be allocated to each signal. If you wish to 
use a channel in another location don’t reconnect to a signal, simple select the channel from 
the drop down menu. 
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Timers/Counters: Functions similar to Dash functions. Can be used to create time based 
conditions. 

Animation: Create animations from a number of images. 

Simulation: Simulate the Display to check layouts/functions/conditions etc. before sending 
to a Display. 

Bit Decode: Decodes a bit stream allowing you to send multiple state channels in one CAN 
message 

Backlight Control: A channel to control the backlight brightness, can be set as a constant 
value or varied depending on a particular input or conditions. 

Splash Screen: Set an image to be displayed when the device powers up instead of the 
default MoTeC screen. 

Input Signals: When using a D-Series Dash this allows you to configure the analogue and 
switch inputs to be used in configuration 

Beacons/Lap Timing: Setup a BR2 for lap timing to be shown on the display 

M800 CAN Input: Sets up standard M800 CAN messaging so it doesn’t have to be done 
manually. (Note: If using an M1 ECU a DBC file can be provided by MoTeC on request) 
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The above program is an outline of the topics covered in today’s seminar. If you have a 
question at any stage, feel free to ask. 
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One of the main features of the Dash is its data logging functionality, which gives us the 
ability to record all sensor values. 

This allows decisions to be be made on engine, driving and chassis setup. Data Logging is 
used to record quantitative data (facts) about performance of these areas. 

• Monitor the drive train in all parts of a lap to look for unusual changes. 

• Confirm driver feedback about what is happening in the vehicle, and its handling. 

• Sampling rate is determined by the sensor being logged - must log fast enough to record 
important data variations. 

• Maximise information available in a test session. Data logging will record everything that 
happens if it is correctly setup, defined and calibrated.  

• Data can be used for planning future setups, driver coaching, comparison run to run or 
with other drivers. 

• Help diagnose faults and optimise performance, e.g. check fuel and oil pressure are stable 
during the session (no surges), brakes/tyres up to temp. 

• Overlay data before and after a chassis change to analyse its effect on the chassis. 

• Measure oversteer/understeer at individual corners for planning chassis adjustments. 

• Measure braking ability of vehicle (and driver). 

• Compare all elements of a lap against a Reference Lap to understand chassis changes, 
driver technique, tyre performance etc. 
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A list of sensors available for comprehensive measurement of vehicle and driver 
performance. 

 



Copyright MoTeC 2015     Page 137 

Channel Overview 

Channels are used to convey information between the various systems of the Dash. For 
example, an input sensor may feed a channel called ‘Engine Temperature’. This channel may 
then be used by any other system, such as the Display or Data Logging systems. 

Channel Usage 

The Dash channel scheme allows complete flexibility in channel usage, as any available 
channel can be used by any other function, i.e. any channel can be logged, displayed, used in 
conditions and/or used in alarms. 
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The onboard data recorded into the logging device is downloaded to a PC, either each time 
the vehicle comes into the pits or at the end of a race, rally, drag run or test session. 

The available memory varies greatly from system to system and more recent logging devices 
use Ethernet communication for fast download.  

 



Copyright MoTeC 2015     Page 139 



Copyright MoTeC 2015     Page 140 

There are two levels of analysis functionality: i2 Standard  and i2 Pro. This list shows some of 
the major differences between the two software versions. 

i2 Standard is available to all customers with logging from a MoTeC Data Logger or ECU. It 
has been designed with the intention of being suitable for teams up to around mid-level 
motorsport.  

i2 Pro provides all the features of Standard but on top of that are extra features that have 
been requested by professional race teams worldwide, like advanced mathematics, multiple 
overlay laps, and unlimited components, Workbooks and Worksheets, and viewing Live 
Telemetry data via T2. It is expected to be used by those in middle to upper levels of 
motorsport. 

There are two ways to make log files compatible with i2 Pro:  

1. The first option is a Pro Analysis upgrade on your ECU or logging system. This is a 
password enabled upgrade, which saves all log files from the device as 'Pro' files.  
The Pro Analysis upgrade can be purchased at any time, allowing you to use the more 
powerful software when the need arises. This can even be done at the race track, you 
need only contact your dealer and they can supply the password to upgrade your specific 
device. 

2. The second method is via the Feature Licences, which allow data in different formats to 
be used with i2 Pro.  
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While a software and resource USB is included with MoTeC products, the software is 
regularly updated so it will become necessary to download the latest versions from the 
MoTeC website.  

Installing Software 

1. Go to the MoTeC website at http://www.motec.com.au/software/latestreleases  
OR  
Locate the Dash Manager software on the MoTeC Resource USB 

2. Save the selected file in your preferred location (for example Desktop) 

3. When downloading is finished, double click on the file and select run. 
Note: the time taken to download the file can vary widely and will depend on the speed 
of the connection to the internet. 

4. Follow the instructions on the Install Shield Wizard 

To be informed of the latest software releases you can join the MoTeC software announce 
mailing list by sending an email to mailto:announce-subscribe@motec.com.au 

 

 

 

 

 

 

http://www.motec.com.au/software/latestreleases
mailto:announce-subscribe@motec.com.au
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To start the program after installation, click the icon on the desktop or click Start > All 
Programs > MoTeC > i2 Pro 

A Workspace stores the i2 program settings, screen layouts, math calculations etc. used for 
analysis. Workspaces can be defined per vehicle, by type of racing etc. A user can create as 
many Workspaces as they wish, each with different settings. New Workspaces can be 
created or existing older projects opened from the File | Workspaces menu or from the i2 
start up page. Any log file can be opened from within a Workspace, so a Workspace doesn’t 
restrict what information can be analysed.  

The first time that i2 is run, the user is prompted to create a New Workspace. Follow the 
prompts of the wizard to create the first Workspace. 

If upgrading i2 Pro to version 1.1, the name changes from Project to Workspace. The older 
projects can be imported from the File | Workspaces | Open Workspace menu. Click Import, 
at the bottom of the import window, you will need to change the ‘Files of type’ to be i2 
1.0.Project. 

When opening i2 Standard for the first time you will be presented with the choice of 4 
projects: Circuit, Drag, Rally and Engine. If you click on the box ‘load previous project’, on 
subsequent program starts it will take you straight into your graph screens, ready for you to 
open your data. 
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Creating a New Workspace: 

Workspace Type: There are 4 types of project available: Circuit, Drag, Rally and Engine. The 
project type determines the default math settings and initial Workbook and Worksheet 
setups and optimised for that particular data analysis . 

Workspace Location: Enter a descriptive project name. This will be used as the folder name 
under which the project is stored. By default, projects are created in the current user’s ‘My 
Documents’ folder under ‘My Documents\MoTeC \i2\Workspaces\Workspace_Name\’ This 
can be changed by clicking on the button next to the Workspace Location and browsing to 
the destination folder. Renaming the folder will rename the Workspace. 

Profile Worksheets and Maths are included if the box is checked, otherwise the project is 
blank with no predefined maths or screen layouts. 

Workspace Summary: After checking the project summary, click on Finish to close the 
wizard and begin using i2. 

The entire project folder can be copied from one PC to another and some of the components 
can also be copied. The project folder and its directory structure contains individual files for 
channel maths, setup sheets, track maps etc. 
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Workbooks and Worksheets 

Worksheets are used to contain the screen layouts, i.e. where the data is actually displayed. Each 
Worksheet is completely configurable and may contain a number of different components such as 
Graphs, Histograms, Gauges etc. These can all be mixed together in any one Worksheet. 

Workbooks are used to group a number of Worksheets. This allows a large number of Worksheets to 
be defined and organised into categories to suit the user’s requirements. A Workspace can contain 
any number of Workbooks which in turn can contain any number of Worksheets. 

 

Selecting a Worksheet 

To select a Worksheet use the mouse or press F7 to activate the Select Worksheet dialog or press the 
corresponding number key that is shown on the Worksheet tab. 

Keyboard shortcuts 

Worksheets may be selected by pressing the corresponding number key (0…9) 

Workbooks may be selected by pressing the Ctrl key plus the corresponding number key (Ctrl+0…9) 

 

A Circuit Racing project comes with 8 pre-defined Workbooks, each with a number of pre-defined 
Worksheets, i.e. there are 10 pre-defined Worksheets in the ‘Sample’ Workbook, several others such 
as ‘Driver’, ‘Engine, ‘suspension, etc. and one blank Worksheet in the ‘User’ Workbook. A Drag Racing 
project currently comes with 8 pre-defined Worksheets in the ‘Sample’ Workbook and one blank 
Worksheet in the ‘User’ Workbook. 
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Creating a new Workbook 

To add a new Workbook, go to the ‘Layout’ menu and select ‘New Workbook’. Or this can be 
done from the Layout Editor (menu ‘Layout – Layout Editor’, shortcut key ‘Ctrl+F7’ then ‘Add 
Workbook’) or right-click on the Workbook list and select ‘New Workbook’.  

 

You will be prompted to enter a name. To rename a Workbook, right click on the drop down 
list and choose ‘Rename’ or use the Layout Manager. 

 



Copyright MoTeC 2015     Page 146 

Creating a new Worksheet 

To add a new Worksheet, go to the ‘Layout’ menu and select ‘New Worksheet’. Or this can 
be done from the Layout Editor (menu ‘Layout – Layout Editor’, shortcut key ‘Ctrl+F7’ then 
‘Add Worksheet’) or right-click anywhere on the Worksheet tabs area and select ‘New 
Worksheet’.  

 

You will be prompted to enter a name. To rename a Worksheet, right click on the tab and 
choose ‘Rename’ or use the Layout Manager. 
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Open Log File dialogue 

A log file can be opened by going to the ‘File’ menu and selecting ‘Open Log File’, by using 
the keyboard shortcut ‘Ctrl+O’ or by clicking on the Open Log File icon on the toolbar. 

On the left is a folder view with the currently open folder highlighted in grey, the folder 
name is also shown at the top of the window. Full details of the currently selected file are 
shown in the pane on the right. 

Files shown can be filtered by the Venue, Driver name or Vehicle details by selecting one or 
more of these from the drop down lists. 

Files can be sorted by the columns shown at the top of the centre pane by clicking the 
heading once – and again to reverse the order. 

Columns shown and their order can be selected from a list by clicking on the ‘Options’ 
button or by right-clicking on the row of headings to a list of selectable headings. 

Select the required file and click on ‘Open’. 

Multiple files can be opened at once allowing data to be selected from a number of sources - 
when a file is opened, previously opened files remain ‘open’. Files can be closed individually 
or as a group. 
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Data Window 

Press F8 to go into the data window.  

This window lists files that are currently ‘open’ that you may choose to view. You can open 
as many files as you like from any folder on your computer. Once one or more files have 
been opened they will appear listed down vertically along with some file details as shown 
above. 

Use ‘R’ to select the first overlay lap, and ‘O’ for an additional overlay. Otherwise press ‘M’ 
or ‘enter’ to select the Main lap. The fastest lap in a session is highlighted in orange. The F4 
key toggles the overlay lap on and off. F3 toggles variance. 

One lap is chosen as the ‘Main’ lap, this is indicated by a red dot in the circle next to the lap 
time. The next column across is for the ‘Overlay  0’ lap. This is actually the first overlay lap 
(displayed on those components that only support a single overlay) and is also used for the 
variance calculation. The third column is for additional ‘Overlay’ laps that are displayed on 
graphs and in channel reports. The Main, Overlay 0 and Overlay laps can all be from different 
files or sessions. The trace colour of an overlay lap can be changed by clicking on its label in 
the title bar above the main display. 
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Adding Components 

With a new Worksheet now open you are still unable to view any data until a component has 
been added. Right click anywhere within the blank new Worksheet and a list of available 
components will appear. Or use the ‘Layout’ menu to select a new display component. 

To add a Telemetry Component you will need to add a telemetry stream to the Workspace. 
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Time / Distance Graph 

Select ‘Add – Time Distance Graph’ from the menu bar. 

When adding any new component, initially the software presents the relevant component’s 
Properties dialog box. This allows the user to organise the component with the desired 
channels to view and the format they are to appear. The user can access the Properties 
menu for the currently active component at any time by pressing the ‘F5’ key. 
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Press ‘C’ to open the Channel list fly out. Double click on a channel to add it to the display 
component that currently has focus. 

Or, press ‘Tab’ to go into the channel list, arrow up and down then press ‘Enter’ to add a 
channel. The list of channels displayed can be narrowed down by typing the first few letters 
of one or more words of the channel name into the search box to make finding the required 
channel easier. 

You will find that some channels are grouped together, while others remain on their own. 
The time/distance graph that we have added is being divided into ‘Groups’. Each Group can 
have one or more channels on it. If we add channels that have the same units they will be 
placed on the same group, channels with different units are given a new group. 

It is possible to change the default behaviour and arranged channels according to how you 
want them in each case. This is done by accessing the Properties for the time/distance graph. 
Or hold down the ‘Ctrl’ key when clicking on a channel in the list to force the channel into a 
new Group (i.e. a separate graph). 

Click on the group containing corrected speed to set the focus to that panel 

Press the C button to bring up the channel fly out 

Type ‘Gear’ into the search bar 

Double click on Gear 
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The Channels window is used to add channels to the display component for the currently 
selected ‘Main’ logged data, and the selected component display on the Worksheet. This 
component is the one with the highlight box around it. 

The list can be displayed in categories: logged channels, status channels and various maths. 
Or they can be displayed as a combined (alphabetic) list. 
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The first sample Worksheet includes two graphs. The top graph displays a single lap of data 
of 5 channels in four groups. The lower graph shows the Corrected Speed channel over the 
entire session. The cursors on the 2 graphs are linked, and the currently selected lap is 
highlighted in a green rectangle on the second outing graph. 

Lap selection bar: grab to scroll through laps, double click to select a lap, grab edges to zoom 
in/out. 
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Time / Distance Axis 

The graph may operate in time or distance mode – the F9 key toggles the horizontal axis 
between time and distance. The mode is remembered for each Worksheet and all 
components on the Worksheet use the same mode. 

The graph uses the corrected distance (Corr Dist) channel to determine the distance for the 
axis when in distance mode. If the Corrected Distance channel cannot be calculated then the 
graph will not display data in distance mode. Note that the Corrected Distance calculation 
normally requires that the Corrected Speed calculation is working. 

Active Channel 

Each graph has an active channel. A square next to the channel name indicates which is the 
active channel.  The active channel can be selected by clicking on the channel label or by 
using the PgUp & PgDn keys.  

This is required for operations that are initiated via keyboard shortcuts. For example the 
shortcuts from the active channel menu will operate on the active channel. (e.g. Ctrl+Shift+F 
to filter the channel). 

Also when vertical zoom or vertical pan are used via the keyboard they apply to the panel 
containing the active channel.  

The active channel is also used when showing information on a particular channel – for 
example the datum cursor measurements that are shown in the values window are for the 
active channel.  

• Press Page Up and Down to change channel selection. 

• Use the rescale/vertical zoom to horizontally zoom the data. 

• Press F9 to change from time mode to distance mode and back again. 
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This Worksheet includes a graph as well as a selection of gauges. Gauges are most commonly 
used when playing back log data.  

The shortcut key ‘A’ is used to toggle the animation on/off. The playback rate can be 
selected from the drop down list in the middle of the toolbar. 

The gauges are linked to show the channel value at the current cursor position. This can be 
moved using the shortcut keys, or by clicking and dragging the cursor along the graph. In its 
function as a gauge the graph acts as a ‘chart recorder’ with the cursor moving rather than 
the graph scrolling across the page. 

To reorganise the layout in i2 Standard, the ‘unlock layout’ box must be unchecked under 
the Layout Menu.  

It is also possible to copy and paste components when you are setting up screen layouts. 
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Right click in the spare space and choose ‘Add’, ‘Gauge’ and ‘Steering Wheel’. 

Select the channel to display by selecting the button to the right off the channel box 

Type in ‘steer’ and double click on “Steered Angle’ then select OK. 
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Right click in the spare space and choose ‘Add’, ‘Gauge’ and ‘Numeric Gauge’. 

Select the channel to display by selecting the button to the right off the channel box 

Type in ‘Gear’ and double click on ‘Gear’ then select OK. 
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Horizontal Zoom 

Zoom In and Out is normally performed using the Up and Down arrow keys to zoom around 
the cursor, or by dragging the ends of the horizontal scroll bar. The wheel on a mouse will 
also scroll in/out around the cursor. Place the pointer, double click and drag, then click again 
to zoom to the selected level. 

The W key is used to return to the default zoom level, which in the case of lap mode is a 
single lap. Note that if the cursor is placed on a lap other than the current main lap then the 
main lap will be changed to the lap that the cursor is in when W is pressed. 

The F2 key is used to zoom Full Out’ and show the entire file. 

Horizontal Pan 

Horizontal pan is performed by dragging the horizontal axis or by dragging the horizontal 
scroll bar or using the Shift+Left or Shift+Right Arrow keys or the F and B keys (Forward & 
Back)  

Vertical Zoom 

Vertical zoom is performed on the panel for the active channel and can be performed using 
the Alt+Up or Alt+Down Arrow keys, or by dragging the ends of the vertical scroll bar. 

Vertical Pan 

Vertical pan is performed using the Shift+Up or Shift +Down Arrow keys, or by dragging the 
vertical scroll bar. 
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By pressing ‘F2’ you will be able to zoom out to the entire run of your chosen log file. It is 
useful sometimes to zoom out to see any trends in temperatures or pressures over a 
complete outing. In the example above Gearbox Oil temperature is increasing throughout 
the session and may not have reached its peak before the race was ended. 
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When modifying your layout, you can examine active component properties. 

Resize components by dragging edges. 

To move component, hover mouse over the top left corner – the mouse cursor will change 
to a symbol of 4 arrows. 
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Layout Editor 

Press Ctrl+F7 to activate the ‘Layout Editor’. The Layout Editor can also be used to rearrange 
the order of Worksheets and Workbooks as well as rename, delete etc. To rearrange the 
order of Worksheets, highlight one and click on ‘Move Up’ and ‘Move Down’ to change its 
position. 

Workbooks and Worksheets can be ‘Exported’, to be saved as individual files, so they can be 
imported into other Workspaces or copied to another PC.  

The ‘Copy To’ function is used to make a copy of a Worksheet in another Workbook. 
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The Values box shows channel values at the cursor for all channels, with those on the 
focused graph listed at the top.  When Reference and Overlay laps are shown, their values 
are shown in additional columns. 

The Values box can be toggled On/Off using the ‘V’ key. 

It is also possible to show the difference between the Main and Reference laps by clicking on 
the ‘delta’ symbol at the top of the column. Whichever column is selected is used as a base, 
with the other columns showing the difference. 

In the above example the Main Lap column shows channel values, while the Ref Lap column 
shows the difference to the Ref Lap. 
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Channels are divided into ‘Groups’ according to channel units. Use the Graph Properties 
page to add groups – which can contain one or more channels, and then add channels to 
those groups. The ‘move up’ and ‘move down’ functions apply to groups and channels. 

The Remove function will remove either a single channel or a group, depending on which is 
selected. 

Channel properties such as scaling and colour can be accessed from this screen by double 
clicking on a channel, or by selecting a channel then hitting ‘Edit’. Note that these are global 
properties and will be applied wherever this channel appears. 
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Display 

Sets various options for the appearance of the graph. By default the X axis scrollbar is turned 
off. Check the box to turn this back on. This adds a scrollbar at the top of the graph window 
that can be used to move the graph through the data at the current zoom level. 
Measurements, Variance and Status/Errors can be toggled with the ‘M’, ‘F3’ and ‘E’ keys 
respectively. The graph properties can be used for default settings. 

Overlapped 

Shortcut key ‘G’ toggles between Overlapped and Tiled mode. When overlapped, all groups 
are displayed together as though on one graph. Each group still has separate Y axis scaling 
that can be set by making a channel in that group active then using the scroll bar. 

Cursor & Trace 

Select the cursor type, this is selectable for each graph. The traces can be lines or individual 
data points, line width can also be specified. Showing individual samples allows you to 
quickly determine if a channel such as damper position is being oversampled. 

Linking 

By default the cursor is linked across all Worksheets and books. This means that a cursor 
position set on one Worksheet will be in the same position on another Worksheet. To 
change this, go to the particular display element properties (F5) and under ‘Mode - Link 
Options’ uncheck the box ‘Cursor Linked’. The cursor will now be ‘local’. 

Similarly for the Datum cursor – it can be Datum linked to be in the same position on 
multiple graphs. More on the Datum cursor later. 

By default all components are also ‘Zoom Linked’, when the zoom level changes on a graph, 
linked components will display data based on the selected zoom level. It is possible to 
uncheck this option so that a graph can be zoomed independently from other display 
components. 
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Channel properties such as scaling and colour can be accessed from this screen by double 
clicking on a channel, or by selecting a channel then hitting ‘Edit’. Note that these are global 
properties and will be applied wherever this channel appears. 

Channel Name and Quantity (unit type) are shown at the top, these cannot be edited. 

Unit: Display units on all components 

Decimal Places : Displayed on all components 

Colour: The channel will be the same colour in all graphs and gauges. 8 colours are available 
in a colour scheme, these can be changed by clicking on the icon next to the channel colour 
selection. There are also complete colour schemes that can be loaded, e.g. black 
backgrounds. See ‘Tools – Options – Colours’ and then ‘Select Scheme’. You can also add 
colours to your channel colour selection in the same place. 

Up Sampling: How lines are drawn on a graph between sample points. By default this is 
linear, meaning that a straight line is drawn to join data points. This is generally what you 
would use, except for on/off channels such as Brake Status. 

Scaling: Manual: A min and max value may be set for each channel. This allows the 
components to use common scaling avoiding the need to set the min and max for every 
component. Auto: the various components will auto scale the min and max scale unless they 
are specifically set to manual scale. Auto scaling can be bad for noisy data as it often expands 
the trace out beyond the area that you would like to see anyway. 

Information: General information about the channel - Source Type, the sample (log) rate 
and number of samples in the file. 

A complete list of channels can be found under ‘Tools – Channel Editor’, the properties for 
any channel can then be edited from this screen. 
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Right click on a channel name to see the above menu. At the top is shown the channel name 
along with the logging rate. 

Hide channel: removes the trace from the graph, but leaves the label and channel value. 

Remove channel: removes the channel from the graph. If there are no other channels in the 
group, the group will be removed and others automatically expanded to fill the available 
space. 

Edit Maths: is greyed out unless there is a filter or Scale/Offset applied to the channel 

Filter: a channel can be filtered by time or number of samples. This filter is temporary while 
i2 is open and will be lost the next time i2 is loaded. 

Scale and Offset : Correct or adjust data. Changes are stored as local file maths. 

Zero at Cursor: Correct sensors that have not been zeroed. Changes are stored as local file 
maths. 

Previous Channel: Make previous channel on graph the active channel 

Next Channel : Make the next channel on the graph the active channel 

Channel Properties : display the channel properties window 
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At any time go to ‘File – Save All Settings’. 

Under ‘Tools – Options’, there is an option to enable ‘auto-save’ of settings at a specified 
time interval. Additionally, all changes are saved automatically when exiting the program 

General Tab  Save Options 

The project settings can be Saved on Exit of i2 and at regular intervals. If the Save on Exit 
feature is tuned off, i2 will ask if the changes should be saved or not.  

Analysis 

Load data after device unload – data can be downloaded directly from i2 by going to ‘File – 
Get Logged Data’. When this option is checked, that data will be loaded into i2 automatically. 

Autoscale options  

In general for circuit racing untrusted data is from in/out laps. This data is not used in auto 
scale as it often contains values outside that seen during a race. 

Telemetry Tab 

Video Tab 

Codec Preference 

When you play a video in i2 Pro the codec used will determine the visual quality and 
playback performance. 

There are many codecs available and their performance varies widely. To achieve 
consistency in playback quality within i2 Pro, MoTeC recommends the MainConcept codec. 

The Download Codec link will connect you to the MoTeC website where you can download 
the MainConcept codec. (Internet connection required). 

Colour Tab 

Change individual colours or select an overall colour scheme. 

 

 

 

 

http://www.motec.com/vcs/vcscodec
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This function provides a Histogram of any channel(s) from the current file. 

For example: If RPM is selected, it can be useful in determining where the engine is spending 
most of its time and therefore identifying where the development effort should be targeted, 
as well as identifying maximum revs and the duration of time spent there. 

The Histogram can be viewed as a chart, individual bar graph and a stacked bar graph. The 
values shown can be a percentage of the time shown or actual time in seconds. This can be 
selected in the Properties section (press F5).  

The duration of the Histogram can be for a single lap or the entire logged session. Use zoom 
functions on a graph to select the time period you wish to view, i.e. the outing graph above 
is used to control which part of the outing the histogram is being calculated from. This can 
be changed using the normal zoom keys, up/down or the mouse thumbwheel. 

For example: A histogram of the gear channel to show how much use each gear is getting – 
determine when to replace parts. 
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The Histogram consists of a user definable number of bins that the logged data is placed into 
which shows how often a certain channel values have occurred. 

The histogram may be displayed in various styles: bar, line and text and may be optionally 
colour coded against another channel. For example: If RPM is selected, it can be useful in 
determining where the engine is spending most of its time and therefore identifying where 
the development effort should be targeted, as well as identifying maximum revs and the 
duration of time spent there. 

Colour Channel 

The histogram may be colour coded against another channel. The bar chart ‘stacks’ are 
divided according to the value of another channel, e.g. throttle position on top of engine 
RPM as above. In the Histogram Properties, select the ‘Colour’ tab, then select the secondary 
channel. The rest of the page gives options for the colour channel range and the number of 
colour bands. 
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Zoom Linking 

The data that is displayed is normally for the currently selected range (normally a run or a 
lap). All graphs, histograms, track reports, FFTs, Scatter Plots and Mixture Maps are ‘Zoom 
Linked’. This means that changing the zoom level on one graph will change the zoom level on 
all graphs. This changes the amount of data shown on the other linked display elements. This 
allows you to zoom in on one corner, for example, and view the suspension data just for that 
area. 

Display elements are also ‘zoom linked’ across Workbooks/sheets. This way you can change 
the zoom level on one sheet and then see the same data section on another sheet. 

For display components such as Scatter Plots and Histograms, the shortcut keys ‘F2’ and ‘W’ 
still apply. To zoom within a lap or across multiple laps use a graph to select the zoom level. 

It is possible to disable zoom linking for a specific component by going into the Properties 
page and un ticking the box for ‘Zoom Linking’. 
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A track map provides a graphical representation of the venue at which the logged data was 
acquired. For this function to be available it is necessary for the following inputs to be 
logged: lateral G force, vehicle speed and a lap beacon. Or GPS data and a beacon. The 
software will then derive a map based upon the driving line of the fastest lap in the log file. 
The map allows the user to relate the data to the specific track position where an event has 
occurred. 

In i2, track maps can be used to show a graphical representation of data logged in the log 
file. It can of course show the channels Throttle position, Brake Active and Gear, but can also 
be used to show oil pressure across a lap, or braking pressures for instance, as shown in the 
rainbow track map examples above. 
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The Track Editor is used to generate/regenerate a track map, create/modify sections and 
add new section categories. These can then be used to generate a time report or channel 
report, e.g. divide the track into 3 sectors for a time report. 

The Track Editor can be accessed from the menu ‘Tools – Track Editor’, by right-clicking on a 
track report and selecting ‘track editor’, or by right-clicking on any track map and selecting 
‘track editor’. 

A track map will automatically be generated from data from the fastest lap that is selected 
on a venue for which no track map currently exists.  
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Distance Channel is ‘Corr Dist’ by default and lateral G is ‘G Force Lat’; other channels can be 
selected using the button next to the channel name. There is an option to use an invert of 
the lateral G channel if the sensor calibration had been reversed. The track length can be 
entered manually or use the calculated length of the current lap. If the length is changed, the 
shape will remain the same, but the map is rescaled to the new distance. 

Note that after regenerating a track map, the sections may need to be recalculated. This is 
done from the main Track Editor page. Again the distance and lateral G channels can be 
selected, along with a ‘lateral G threshold’. This determines the changeover value between 
straights and corners. 
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It is not the right type of track: When the track map is displayed, right click on the track. 
Select ‘Track Editor’ and then click ‘Generate Track’ button, choose between Closed, 
Crossover Circuit or Open Circuit. 

The orientation of the track is wrong: When the track map is displayed, right click on the 
track. Select ‘Track Editor’.  Use ‘Rotate Model’ slider. 

The ‘Curvature’ parameter will alter how ‘sharp’ the corners are, a positive number will 
make the turns tighter, a negative number will do the opposite. This number can be set 
between –100 and +100. 

This is sometimes required due to low sampling rates that distort the shape of the circuit 
slightly and hence this feature enables us to either ‘fatten’ or ‘thin’ the circuit down as 
required 

The radiuses of the turns are either too small or too large: When the track map is displayed, 
right click on the track. Select ‘Track Editor’ and then click ‘Generate Track’ button, the 
curvature can be adjusted. 
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Open the logging and display the Lateral G, Longitudinal G (if fitted) and Wheel Speed. If 
either of these will not display then they are probably not being logged and the map will not 
be drawn, check your Dash Manager setup and your sensor wiring. 
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Select the Workbook ‘Samples, then add a new Worksheet by right clicking on the 
Worksheet name area. 

Call this sheet ‘Track Maps’, then right click on the page, then select ‘Add’, ‘Track Position’. 
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The Track Report shows channel statistics on a Track Map based on track sections. The 
channels shown are fully configurable with a statistical calculation performed over the 
section in question. 

Press ‘F5’ to see report properties and select the channels shown. They can also be displayed 
for a particular section type only, e.g. Max Speed on the straights, Min Speed on the corners.  

The report may use the default sections or user defined sections. The notes point to the 
position on the track at which the event occurred. This means that engine RPM is shown at 
the point of maximum speed, for example. 

The notes may be moved by dragging them if their positioning is not suitable. It is worth 
remembering that once a note is dragged, all others will maintain their positions until 
‘Automatic Note Placement’ is reselected under Properties - Display. 

Additional channels can be used to ‘colour’ the track. These are added in layers with a 
channel lower in the list only being visible if the channels above it are not being displayed at 
that point. 
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Right click on the page, then select ‘Add’, ‘Track Report’. 

The Notes: The Notes (value boxes) can be shown for each section of the track or at the point that the channel 
changes. The section notes may show various channel statistics for each section such as min max or average. The Note 
may also show the value of other channels at the same point in time where the statistic occurred, for example a Note 
may be configured to show maximum speed for the section, in this case it may be useful to show the Engine RPM at the 
same point in time. 

Report On Track Sections: The sections used for the report may be selected to base the report on the default sections 
or on user defined sections. 

Report Formulas: The following formulas are available: 

• Section Average 

• Average channel value for the ‘Report on’ range 

• Minimum 

• Minimum channel value for the ‘Report on’ range 

• Maximum 

• Maximum channel value for the ‘Report on’ range 

• Absolute Maximum 

Maximum ‘absolute’ (maximum positive or negative) channel value for the ‘Report on’ range 

Value at Start: Channel Value at the start of the ‘Report on’ range 

Value at End: Channel Value at the end of the ‘Report on’ range 

Value Change: The change in value between the start and end of the ‘Report on’ range. 

Standard Deviation: The standard deviation of the channel value for the ‘Report on’ range. 

On Channel Value Change: Shows a note every time the value changes. This is useful for channels that change 
infrequently such as gear. This formula ignores the report on range. 

Filter by Section Type: Each note can be filtered by section type. For example if the Report On range is set the default 
sections then the notes can be filtered by Corner or Straight, this means that notes will only be placed for the section 
types specified in the filter. 

Moving the Notes: The notes may be moved by dragging if their positioning is not suitable. Once a note is dragged, all 
notes will maintain their positions until Automatic Note placement is re-selected from the component menu. 

Track Colour Channels: The track can be rendered in a colour gradient according to one or more channels. When using 
more than one channel, the colours are layered. In this case the channel on top must include gaps so that the channel 
below can be seen. For example the brake status can be setup such that it only shows colour when the brake is applied 
allowing the channel beneath to be seen during the non-braking periods. The default configuration for the track report 
shows how to do this. The channel that is first in the list is the channel that is rendered on top.   
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Select the Workbook ‘User’, then add a new Worksheet by right clicking on the Worksheet 
name area 

Call this sheet ‘Rainbow Track Map’, then right click on the page, then select ‘Add’, ‘Rainbow 
Track Map’. 

Click on the button to the right of the ‘Colour Channel’ box, and choose ‘G Force Long’ 

Click on the number of bands, and change it to 5, click the ‘Reverse’ button, then finish with 
‘OK. 

Right click on the page, then select ‘Add’, ‘Rainbow Track’. 
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Although distance is generally calculated in the Dash Logger, i2 also performs a distance 
calculation to give what is known as ‘Corrected Distance’. Corrected Distance must be 
calculated so that the graphs can be plotted against distance rather than time. This allows 
laps to be compared at the same distance point on the track – the only way to make a 
meaningful comparison. To ensure that the distance is as accurate as possible, there is an 
option to calculate a ‘Corrected Speed’ channel from one or 2 input channels, along with 
Longitudinal G correction to account for wheel lifts or lock ups. 

Setup for Corrected Speed is under the ‘Tools’ menu. By default Corrected Distance is 
calculated from Corrected Speed, however another speed channel can be selected as the 
input to this calculation. To account for variations in the measured speed and resulting 
distance from one lap to another, lap lengths are stretched to match the track length. This 
allows for consistent comparisons across different laps and sessions. 

On the ‘Corrected Distance’ tab there is a button labeled “Report”. Click this button to show 
the distance report of all laps. This report shows lap stretch or shrink to allow for slight lap 
length variations. You can turn this on or off in the previous screen, as well as set the 
maximum stretch/shrink percentage. 
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Overlaying allows the differences between two laps to be accurately determined. i2 can 
display the variance  - the cumulative time difference or delta time - between two laps. This 
shows where time was gained or lost between the two laps being compared to indicate 
which sections of the lap need further investigation. 

Analysis of vehicle speed, throttle position, and lateral G force allows differences in braking 
points, use of throttle and the line through the corner to be evaluated to provide direct 
information on how the vehicle and driver have changed between the laps being compared. 

Comparing two laps is one of the best ways to find places where your car or driver can 
improve. Using two laps of data, select one as the Main lap, and the other as the reference 
lap. When you do this, it puts the overlayed data in black (colour can be changed) alongside 
the Main data. One thing to remember when overlaying laps is to always do it in distance 
mode, not time. The reason for this is that if you are comparing two laps, the track distance 
will be the same lap to lap, so your speed, throttle, pressure and other readings are 
compared at the same points on the track. If you try to compare the data using time, as you 
lose time over the lap, the traces become no longer aligned, offset by the amount that one 
lap is slower than the other. 
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By pressing F3, you can insert a variance trace at the top of the Worksheet as shown above. 
As you can see, the variance line shows where one lap has gained or lost time over the other 
lap. This is a useful trace to find the points on the track where the most time has been 
gained or lost, showing the driver what part of the track to focus on to make gains in time. 
As a starting point look for the steepest slope or biggest jump in the variance line, then zoom 
in on that area of data. 
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Overlaying data from different drivers allows for quick identification for where one driver 
may be quicker than the other, by means of different line being driver, braking/turning/ on 
throttle at different times. 

Overlaying the same car but run to run can help in identify where a chassis change has had 
effect on the car balance and handling. 
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In some instances you may be comparing data from different sessions where the beacon has 
been moved. In this case it becomes necessary to offset one lap relative to another. This can 
be achieved using the ‘Offset Axis’ feature of i2. 

To allow precise alignment of main and reference, each may be offset in time or distance. 
This is done by turning on the offset axis by selecting Show Offset Axis from the graph 
component menu or by pressing the ‘O’ key.  

This shows an axis for the main and reference below the nominal axis, which allows either 
one to be dragged relative to the nominal axis. Dragging can be performed using the mouse 
or by using the keyboard shortcuts: Ctrl+Shift+Arrows to move the main lap or 
Alt+Shift+Arrows to move the Reference Lap. 

Offsetting may be turned off by pressing the O key again, this will also zero the offsets for 
the main and reference laps. Normally offsetting is used to make small corrections to allow 
for slight difference in the distance calculation from lap to lap. The best way to align laps is 
to look at bumps in the track surface using either the vertical G channel or a suspension 
position channel. 

An offset can also be entered in seconds or meters by right clicking on an offset axis and 
selecting ‘Set Offset’. 

Press ‘O’ to show the offset axis 

Click and hold on either the ‘M’ or ‘R’ axis, and drag it around to line up the data. 

Remember to be in distance mode for overlays (F9) 
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Status channels are used within data logging to indicate when an on/off condition has 
occurred. Examples of this include a brake switch, shift lights, alarm/warning light, alarm 
acknowledge button, full throttle switch, clutch switch, nitrous activate and more. It is useful 
to see this information in the context of the rest of the data, knowing just where on the 
straight the nitrous is being activated, and what that is doing to your ignition timing, air fuel 
ratio and ground speed.  

By pressing ‘E’ you can turn the status conditions on and off viewing them only as required. 
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Global Maths 

Global maths is calculated for all log files that are loaded. Global maths is stored in maths files 
within the project. Multiple maths files can be used, which allows the maths to be separated into 
functional areas such as Engine, Chassis, Aero etc. The global maths files may be copied to other 
projects by clicking on the Import and Export buttons in the Maths Editor. An example of maths 
that may be useful as global is a Lateral G filter that you always apply to your car to give your 
data a comparable trace. 

Local Maths (Maths per log file) 

Maths may also be created per log file. The local maths is stored alongside the log file in the 
companion (.ldx) file, the original file is never modified. This would normally be used for things 
such as setting the steering trace to 0 if you had forgotten to do so before the session. 

Order of Calculation 

The order of the maths equations in the list does not matter. Any dependencies are determined 
at calculation time so that if a maths equation requires other maths channels then the required 
maths channels will be calculated first. 

On Demand Processing 

The maths equations are processed on demand, i.e. as different Worksheets are displayed the 
required maths channels will be calculated as the Worksheet is displayed (unless they have 
already been calculated). 

Maths Status 

The status of the maths calculations is available in the Tools | Channel Status dialog. Note that 
any maths channels that have not been displayed or otherwise required will be tagged as 
Pending due to the "on demand" processing scheme. 

Constants 

Constants are used to represent common factors such as Pi. Maths Constants are stored in the 
maths files and can only be accessed by maths within that file. 

Maths File constants are specified in the Maths Expression Editor. 
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Maths Expressions are powerful maths formulas that are entered in plain text format. 

Channel Names Used in Expressions 

When entering channel names into an expression, all channel names must be enclosed in single 
quotes, for example: ‘Engine RPM’. The quotes are added automatically if selecting a channel 
from the embedded channel list. Channel names are not case sensitive so ‘Engine RPM’ could 
also be entered as ‘engine RPM’ 

Units of Channels Used in Expressions 

When entering an expression, every channel should be followed by units in square brackets. For 
example: ‘Wheel Speed Front Left’ [km/h] 

The units specified are the units that the channel value is converted to before the calculation is 
performed and thus affects the resultant number and the appropriate result units (see below). 

Note that when a channel is selected from the channel list, the default units will be automatically 
appended to the channel name. If the units are not the desired units then they may be edited as 
necessary. When typing the units a help window will show the valid units for the particular 
channel.  

Maths Functions 

An extensive set of maths functions is provided for use in the expressions. 

For details on the available maths functions and associated parameters see: Maths Functions  

Result Units 

The result units of the expression must match the numeric result of the expression. 

Note that the result units need not be the same as the display units. It is very important to 
understand this difference. 
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Maths Channel Name 

The name of the resulting maths channel is specified in the expression editor.  

The maths channel name may contain any character except single quote ( ‘ ). 

Sample Rate 

The sample rate specifies the sample rate of the resultant maths channel. 

If the channels used in the expression do not have the same sample rate then they will be re-
sampled to the result sample rate before the maths expression is run. The re-sampling function 
uses linear interpolation to determine the values at the new sample rate. It is normally best to 
use a sample rate that is equal to the highest sample rate of the maths input channel(s). 

Auto Sample Rate: The Auto sample rate selects the highest sample rate of the input channels 
and is therefore suitable for most maths processing. 

Quantity : The quantity must be set so that valid display and result units can be set. 

Display Units, Decimal Places, Colour: Sets the default values for these channel properties. 

 

Enter this expression for Brake Bias Calculated: 
(‘Brake Pres front’ [psi] / (‘Brake Pres front’ [psi] + ‘Brake Pres Rear’ [psi])*100) 
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When driving in the car with Lap Gain/Loss displayed, the driver can get instantaneous 
feedback on the car, the driving and the current lap. A driver can determine the following 
easily with Gain/Loss: 

• Which specific corner or straight is most of the lap time being gained or lost on? 

• Which part of the corner is the time gained/lost? 

• Is this lap going to be a fast one? 

• Should I pit this lap for a change, or complete the lap? 
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When connected to the Dash, go to the Online Menu and find ‘Set Reference Lap’ to send 
your lap. 

Click on Browse button and select Reference Lap then click Open. 
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The Channel Report shows channel statistics in a tabular form. 

The report may be configured to report on various ranges including: 

Report on Laps for All Laps 

Report on Laps for the Selected Laps 

Report On Sections for Selected laps (either the default sections or user defined sections 
may be used) 

The statistics available are: 
Average, Minimum, Maximum, Absolute Maximum, Start Value, End Value, Value Change & 
Standard Deviation. 

Reports for selected laps (not all laps) can also display data from the Reference and Overlay 
laps when these are selected. Also shown is the difference between the Main and Reference 
laps. 

Press ‘9’ or select ‘Chan Report’ from the ‘Samples’ Workbook 

Click on the top channel report to give it focus and press ‘F5’ 

Select ‘Add’ then search for fuel pressure and double click on it. 

Turn on the tick box for minimum and click ‘OK’. 
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The i2 Channel report is the best way to get summary data about your outing. This data is 
often under utilised but can be a very powerful tool for trying to maintain the reliability of 
your vehicle. By checking this information at the end of each session you may notice trends 
in the temps, pressures, speeds or voltages of your vehicle.  

This screen can show you the data in a lap by lap arrangement, useful to make sure that the 
data is from a lap where the car is at racing speeds. This is important to consider as there is 
no use looking at the minimum oil pressure on a lap when the engine was not running, or 
taking engine temp from a lap where the vehicle is stationary and heat soak is affecting 
temperature readings.  

The data can also be shown in an outings mode where it just shows the min/max readings 
for an outing. You can even choose to exclude ‘untrusted laps’ which means that it doesn’t 
include data from your in or out laps in the calculations of your statistics, a problem that 
often skews statistics of an outing. 
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Exhaust Gas Temps come in either ‘open tip’ or ‘closed tip’ versions. 

The closed tip type are more robust and will last longer, but they have a slower response 
than the open tip sensors. 

Sensors 

Top Row: Infrared tyre temp, infrared brake temp, infrared tyre temp 

Bottom Row: Delco Air temp, EGT, installed Bosch water temp 
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If we look at the engine temperature trace, we can see that it started at around 80 degrees, 
and fluctuated up and down for a while. At around –250 seconds (from the start of the 
selected lap) we can see that the temperature peaks at over 100 degrees. 

It is important to consider for what reason are you looking at the temperature. Are you 
looking for peak temperature to decide if a thermo fan is required for times on the grid or as 
the car cools down at the end? Perhaps you are looking at racing laps only, so that you can 
see if there is sufficient cooling during a race situation. The answer to this determines where 
and how you should be looking at the data. 

If you are keeping a log of maximum temperatures that an engine has reached, it is usually 
best to look at peak racing temperature rather than a stationary temperature.  

Press F2 to look at the temperatures across the whole session. 
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You can see that at speed the temperature is still climbing. There is a cooling problem and it 
would be a good idea to stop driving and investigate the situation. 
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Typical pressure sensors used in motorsport applications. Some sensors shown here can be 
used to measure brake, crankcase, fuel, oil and water pressure. MoTeC sells a wide range of 
sensors with varying measurement ranges. The most accurate measurements are made with 
sensors that are correctly sized for the application. 

Response and accuracy vary between different types of sensors.  
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Pressure traces are often vital in examining the health of your vehicle. Whether it be fuel, oil, 
brake, manifold or other pressure, checking these values after each outing is an important 
part of ensuring that the engine is running safely.  

It is common to see very noisy fuel pressure readings, although sometimes it is believed that 
the noise is the logger or the sensor.  

Looking at fuel pressure data from even highly developed race engines, it is common to see 
fluctuations of 10-15psi when a good sensor is used. Don’t assume that the noise isn’t a 
genuine indication of the pressure that is happening in the fuel rail, it is more likely to be the 
actual fuel pressure pulse waves than sensor noise. These pressure waves are often 
dependant on injector duty cycle. 
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To read the traces, again from the left, you can note that the oil pressure trace has some 
alarming dips. 

The first thing to look at is the RPM going up and down to match this, a quick glance we can 
see that’s not the case.  

In this example, a check of the lateral G trace clearly shows the engine losing oil pressure 
each time the vehicle travels around a left hand corner. 
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Here you can see a fuel pressure drop. This could be caused by a number of reasons. 

Items to check : 

Are the Fuel pumps are staying on? 

Possible blockage in the fuel system? 
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Voltage should be logged at 10 Hz as a minimum. They can appear noisy in their trace; this 
could be interference from the alternator/regulator on the vehicle, or possibly the display 
scale is to close.   
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By right clicking on the graph properties, you can rescale channels to a range they work in. 

Above we have scaled the battery voltage. This has smoothed out the trace compared to the 
previous slide .  

You can also add a line to the graph at a Max value and a Min value. 
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An annotation or note can be placed at any point in the data. A line will be placed in the data 
which you can see in all the Worksheets. So, for example, if you have a ‘Wheel Lockup’ 
event, you could also look at the oil pressure on a different Worksheet. 

How to add an annotation:  

• Place the cursor at the required position in a graph 

• On the Component menu, click Cursor  

• Click Add Annotation. 

How to display an annotation:  

• The annotation is indicated by a dotted line on the graph. Place the mouse over the 
dotted line on the graph as shown below 

How to edit or remove the annotation:  

• Place the mouse over the dotted line  

• Right-click and select the appropriate item from the menu  
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The wheel speed sensor is one of the sensors that you get with a data acquisition system.  
Beside speed and distance computation, this sensor will allow you to: 

• Compare the speed of drivers or of cars, lap after lap.  

• Detect the wheel locking under braking. 

• Detect wheel spin. 

• Draw a track map on your screen. 

• To detect the gear you are using without having a defined gearbox sensor. 
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Above you can see all wheel speeds directly determined by sensors on the front wheels, 
overlayed against each other. The green trace shows a GPS speed trace sampled at 10hz. 
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During the study of the various curves, there are two points that are important to 
remember. Firstly, it is important to understand the influence of the logging rate on the 
measurement precision. Then, it is useful to have an idea of the consequences of the driver’s 
mistakes at high speed. 

This table shows the distance in meters between two measurements for different 
combinations of logging rates and vehicle speed. As an example, let’s consider a car 
travelling at 220km/h with a Lateral accelerometer logged at 20Hz: 

Distance travelled per sample at 220km/h is:   
220x1000/3600x20  = 3.06m       

In an average data logging configuration gear changes are recorded at 10 Hz. At 220 km/h, if 
two drivers are changing gear at exactly the same time, on the data acquisition system it can 
appear with a difference of up to 6.11 m. 
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Another very useful tool of the wheel speed comparison graph is to determine wheel lockup.  
To make this comparison, at least two front (or rear) wheel speed sensors are needed.  The 
screenshot above shows all four wheel speeds together.  It can be seen that the rear right 
wheel speed (light blue trace) has a notable deviation from the other wheels. 

If a trace like this is encountered, it means that there is an imbalance in the car setup – 
whether it is caused by the driver, car setup or track conditions. It is worth looking at setup 
parameters other than just brake bias. Uneven corner weights, damper problems, brake pad 
compounds and temperatures and even oil on the track can cause such a lockup.  

As you would do every time you analyse data, be sure that what you think you have 
detected is really happening on the car. Use other sensors such at tyre temps, G sensors, 
brake pressure sensors and brake temp sensors to confirm your hypothesis. Especially here 
with an imbalance under brakes, you may be able to determine the cause of the issue, 
whether it be bias of line pressure or lack of braking friction to the front by looking at the 
braking pressures versus G force and brake temperatures. You may have the same brake 
pressures front to rear, but have less retardation at one end to the other depending on 
calliper piston sizes, pad compounds, rotor types and brake temperatures. 
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Wheel spin is an important thing to be able to monitor in data logging. At the end of a 
session, the driver will reflect upon the performance of the vehicle, and determine what it is 
that is stopping the car from going any faster. Understeer and oversteer are common 
problems that a vehicle encounters at the limit and you want to determine what is causing 
the vehicle to behave in this way. With oversteer, sometimes it is due to the suspension 
settings in the vehicle, whilst other times driving style is more to blame. Determining this is 
an important part of deciding how to go about tackling the problem. 
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What is an accelerometer? 

An accelerometer or G force sensor measures the forces being applied to the car. These 
forces include acceleration, braking, cornering in both directions, up and down. To 
understand what they are measuring, imagine a bob weight being hung from the roof of a 
race car, as you accelerate it swings backwards, as you brake it swings forward. The distance 
of the bob swing represents how much force there is in that direction. A G sensor measures 
this force, and the data logger gives a value proportional to the force of gravity, hence ‘G’ 
sensor. 

• Can be used to measure Acceleration, Deceleration, Cornering, Yaw, Forces etc. 

• Strain Gauges can be used in many ways, damper/suspension forces, steering force, 
pedal forces . 
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What can I get from a 3 axis accelerometer? 

3 axis accelerometers allow the user to measure and record the acceleration of a vehicle in 
three dimensions. By combining the information from all three accelerometer axes it is 
possible to calculate the resultant overall acceleration in three dimensions. 

Accelerometers allow the user to perform fundamental operations, for example obtaining a 
track map or studying the balance of the car in terms of understeer and oversteer. They also 
permit more complex calculations, for example computation of the weight transfer the car 
experiences during braking, acceleration or turning phases. 

It is extremely useful to use the G sensor to compare braking forces and technique in overlay 
mode. You can see how hard the initial deceleration is, and verify that the braking is hard, 
right into the corner, not tapering off at the end. You can also see how consistent the pads 
are, you could compare a brake fluid line pressure to a deceleration force to look for fade in 
the braking system. 

They can also be used to compare how much lateral traction a given tyre/track/suspension 
setting is able to obtain, then compare to another lap to see how your changes have affected 
vehicle cornering grip. 
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Above we can see racing line through a corner. There is also a G-G diagram which is a scatter 
plot of longitudinal and lateral G zoomed on a specific corner. 
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The G-G diagram is a conceptual way of showing the performance of a driver, vehicle and 
circuit together. This method of measuring performance has been around since the late ’50s 
with the first methods of creating these diagrams using a two axis pen recorder.  

In theory, the driver should try to operate as close to the boundary of the G-G circle as 
possible at all times. In reality, physical limitations prevent a vehicle reaching the theoretical 
boundary (e.g. changes in suspension geometry, brake balance, tyre grip, etc). The more the 
driver can push out the envelope of the plot to the ideal circle, the better use he/she is 
making of the available grip of the tyres and the available grip of the track. 

But what is the limit of the vehicle, or the limit with a perfect driver? A G-G diagram is useful 
as a comparison tool.  

Take the example above, the red data is fastest lap from the Daytona sample file, the 
overlayed lap is the fastest lap of the Escort sample file. From this example we can see that 
although the lap times are less than 1 second different, the plots show very different 
characteristics of the two cars. The black data is out further to the left and the right, showing 
more cornering forces from the Escort compared to the Daytona. The Escort also shows 
more samples in the braking area, up to 1.2G deceleration, with the Daytona reaching only 
just over 1g from a far heavier vehicle. The obvious place where the Daytona is better is up 
the top of the G-G diagram, showing consistently greater acceleration. Now this example is 
comparing two different types of car, but it shows how you can overlay different drivers, in 
the same car and learn how, and why one driver is different than another in the way they 
extract speed from a car. 

The best way to obtain high quality data is to use a 3-axis accelerometer mounted at or 
below the centre of gravity. We recommend mounting the sensor on Velcro or alike to 
isolate the vibration in the car from the forces applied to the vehicle itself that we really 
want to measure. 



Copyright MoTeC 2015     Page 225 

The datum cursor is a second cursor that allows measurements to be made between two points. To 
place the datum cursor, position the main cursor to the point of interest then press the ‘Space Bar’ 
key, then move the main cursor as normal. The graph labels now show the values of each channel at 
the datum cursor, main cursor and the difference between the 2 values. 

In addition to this, there are Datum Measurements in the cursor window for the currently active 
channel. The active channel is denoted by the vertical scroll bar next to that trace, by the channel 
value having a box around it, and the channel name is given in the ‘Datum Measurements’ area. 

Measurements: 

Time Time difference between the cursors 

Distance Distance difference between the cursors 

Cursor Value Channel value at main cursor 

Datum Value Channel value at datum cursor 

Cursor Diff Channel difference between 2 cursors 

Cursor Avg Average of the 2 cursor positions 

Cursor Slope Rate of change between the 2 cursor positions (gradient) 

Interval Min Min channel value b/w cursors 

Interval Max Max channel value b/w cursors 

Interval Avg Average of all points between the cursors 

Keyboard shortcuts: 

‘D’ Toggle datum mode (& cursor) on/off 

‘X’ Swap positions of main and datum cursors 
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Datum Cursors are an efficient way to measure the change in a channel across a period of 
either time or distance. Common uses of this include measuring the starting performance of 
a car (0-100km/h), measuring temperature change across a period, RPM rate of change in 
each gear and much more.  
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The above example shows the car leaving the line where the green Datum cursor has been 
placed. The Main cursor has been placed when the car has reached 100km/h.  
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Rate of change measurement is very useful in looking at real world accelerations. You can 
look at gear accelerations to compare to other cars. Just place your datum cursor at the start 
of the measured area, then put your cursor at the end of the area, and select the channel 
you wish to measure. Cursor Slope from the values box will tell you your rate of change. 
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When it comes to fine-tuning a racecar to improve its performance around the track, many 
people focus on the horsepower delivered by the engine and the handling characteristics in 
corners. In fact, the brakes are going to have a significant effect on lap time, as well as lap-
to-lap consistency and driving ease. Fine tuning the brakes allows us to exploit more 
efficiently the grip available under each wheel to minimize the braking distance and facilitate 
overtaking maneuvers during the race. The right brake bias setting will also reduce the risk 
of flat spotting the tyres, and make the car easier to drive. One of the most effective tools to 
monitor the brakes is two brake hydraulic pressure sensors – front and rear. This type of 
measurement will allow you to understand how your brake system is being used and help 
the driver to evaluate its performance after a session.  

Often, a better braking system can make the little difference at the end of the straight that 
allows overtaking another car. As in any other hydraulic system, knowing the pressure of the 
fluid circulating is going to help you to monitor the different forces applied in each of the 
devices connected. Moreover, the driver can make progress in his driving style: comparing 
his braking point lap after lap, the intensity of his braking and his speed on the pedal. 
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It may seem obvious, but looking at the brake pressure traces gives you the time at which 
the driver started to brake. This information is very important, as a few meters difference in 
braking are very important for the speed you carry through the corner, and the time you 
gain or lose. Once again, looking at these traces with an overlay between two laps will 
permit you to perform a quick and efficient analysis of driver style and consistency. 

Be careful with the logging rate used for those channels. If it’s 10Hz for example, the system 
will record one value each tenth of a second. And at the end of the straight, at 250 km/h, the 
car is traveling 7 meters in one tenth of a second. So before concluding that driver A brakes 
21 meters later than driver B at the end of the straight, check if your logging rate needs to be 
increased. 

Directly measuring the pressures in the Front and Rear brake systems allows you to know 
how the driver is braking. In effect, both the shape and the amplitude of the brake pressure 
traces are very important for optimum braking. Most of the time, you want the maximum 
deceleration (indicative of late braking) to reach the maximum speed in the corner without 
losing speed in corner entry and being able to carry the maximum speed in corner exit. 

The shape of the optimum trace can be explained by: 

• Having the maximum deceleration in corner entry 

• Losing the minimum time and speed in corner entry 

• Releasing the pedal progressively and gently while turning 

• Braking hard at the beginning (by literally jumping on the pedal) will be shown as bigger 
pitch acceleration. 
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How much does he lose in heel-toe braking? 

In a braking zone where the driver downshifts gears, it is always interesting to look at what 
happens to the brake pressure during that time. 

We can clearly see that each time the driver downshifts, he is adding a small amount of 
throttle, and because he is doing that the brake pressure diminishes slightly. As this ends up 
being time lost under brakes, the goal here is to lose the minimum of braking pressure while 
downshifting. It is possible to monitor the driver’s progress on this issue using brake pressure 
sensors. 

Brake knock off can be identified when the pressure in the rear builds before the front 
measures. This is due to the front pads needing to be pushed out further before making 
connect with the brake rotor.  
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The scatter plot shows points for two channels where one channel is on the x axis and the 
other on the y axis, allowing for relationships and dependencies between them to be 
identified. 

By default the Scatter Plot will scale according to the minimum and maximum channel values 
of the X and Y axis channels. This can be changed by selecting ‘Manual Scale’ for either 
channel and entering min and max values. It is zoom linked to other Worksheets and will 
display data based on the current zoom level. To see an entire session worth of data press 
F2. Select a different lap using the Data window or the lap select bar above the Worksheets. 

Colour Channel 

The scatter plot allows a 3rd channel to be used to colour each of the data points, the above 
example uses throttle position as the colour channel. The channel selected is divided in the 
number of bands specified and colours assigned accordingly. Data can be removed from the 
plot by unchecking the box next to the range values.  

It is also useful to know that the number of samples logged in the particular band areas is 
shown on the right of the colour. 

Press the up and down arrow to increase and decrease the selected data used to create 
the scatter plot. 
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An XY graph, or Scatter Plot is a graph that shows the relationship between 2 channels. They 
can be used to represent many things, such as gearing, G-G diagrams, Brake bias, oil temp vs 
Pressure and much more. In this instance, we are looking at a Brake Bias Scatter Plot. The 
graph shows brake bias on the Y axis and Front brake pressure on the X axis. What you are 
being shown above is one dot on the graph per sample of combined brake pressure and 
brake bias across the selected session. In the example above, there are 25,449 samples 
across the 24 laps around Calder Park Raceway. 

In a good brake setup, each time that you press the brake pedal to a given pressure, you 
should get a consistent amount of pressure going to the front brake lines, and a consistent 
pressure going to the rear brake lines. The last thing that a driver wants is to press the 
brakes one time and get mostly front brakes, then do the same thing again and get mostly 
rear brakes.The integrity of the brake system is the critical element you must minimize. In 
practice, there is nothing worse than an inconsistent brake system. You can always change 
your brake pads, rotors or calipers, but if your system does not react the same way each 
time you use it, you cannot rely on it. 

What the brake bias knob on the dashboard tells you is one thing, and what really happens 
inside the system may be different, sometimes very different, all because of compliance in 
the pedal box and master cylinder. That’s why it is so interesting to look at changes in the 
hydraulic brake bias. 

This graph is colored to indicate the front brake pressure. We can see that for small 
pressures (i.e. for light braking) the brake bias is very inconsistent, but fortunately, it is 
better when the pressure increases. By plotting this kind of graph, you can either see how 
consistent your braking system is, or compare two different systems. 

• Select Workbook ‘Seminar, Create a New Worksheet, choose ‘ADD’, then ‘Scatter Plot’. 
• Ensure that you still have out lap (1:34.136) from the Calder, i2 data day file from 9:53am 

selected. 
• Click Add type in brake and choose ‘Brake Pressure Front’. 
• Select the button next to the channel box listed under X axis, and choose ‘Brake Bias 

Setting’. 
• Select scale mode, and change it to manual, setting min value to 0, and max value to 100 

• Select the ‘colour channel’ tab, tick the ‘enable colour channel’ box, then select brake 
pressure front as the colour channel. Click OK. 
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 1. Generally for calibration of linear sensors a max/min measurement is taken and the 
points are interpolated. The above example shows a simple way to calibrate such a 
sensor for Steering Wheel Angle.  

 2. We know that at maximum lock the steering wheel angle is 90 degrees. By turning the 
wheel to full lock we enter the number in the right hand column for degrees.  

3. By pressing the READ VALUE button the voltage from the signal wire is read into the Dash 
and displayed in the left column. 

4. This procedure is repeated for straight ahead and the opposite lock. 
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The actual steering trace is shown in orange, an ideal trace is shown as a dashed green line. 

Note that a right handed turn has a positive steering wheel angle, while a left turn has a 
negative angle. Some users will use the reverse. This is ok as long as you are consistent and 
preferably use the same convention for lateral G force. 
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Oversteer 

Oversteer can also be recognised by a loss in lateral G force along with a steering correction 
by the driver and a reduction in throttle. The G force trace is one in which we can see a 
balance problem with the car. The driver is unable to drive the car hard out of the corner for 
fear of spinning the car around, hence the decrease in lateral Gs at the exit of the corner. 

If we examine the steering trace we will be able to see how the driver is reacting as the car 
exits the corner. It is useful to be able to see this, as you can use it to measure the reaction 
time of the driver to the oversteer, and perhaps be able to better quantify just how severe 
the oversteer is. This is an important measurement to make when trying to solve a handling 
issue; yes the car may still oversteer, but have we made an improvement or not? 

After observing the steering trace it is clear that the driver has quickly reacted to correct the 
situation by opposing the direction of the corner to prevent the car from swapping ends. A 
throttle lift often accompanies this trace, as it does in this case, but sometimes the driver 
decides to power through the oversteer to compensate for the loss of cornering grip with 
pure forward acceleration. 
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In this example the driver has turned into the corner and stopped moving the steering 
wheel, this is evident by the flat trace, at this point the driver has began to introduce some 
throttle, this further adds to his understeer. 

The driver of this vehicle has than induced a rapid change in throttle position to help induce 
some oversteer to make the car rotate as the front wheels are no longer turning the car. 
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Track maps in i2 can now be created purely from the GPS data with no other sensors 
needed. See example above. i2 will allow also you to use an export function to place your 
driver’s line into Google Earth. The function is under the ‘File’ menu and creates a kml file 
that is compatible with Google Earth from the position data that is currently visible on the 
graph. Note the red trace in the image above right. 
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Open the log file that is missing laps but has GPS Latitude and Longitude logged. 
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You can see that there are no laps in this data. 
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Add a ‘GPS Track’. 



Copyright MoTeC 2015     Page 244 

Go into ‘Lap Editor’ and click ‘By GPS’. 
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Enter the GPS Co-ordinates and click Execute, then click Close. 
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The Time Report shows split times in a tabular form. The sections that are used may be the 
default sections or user defined sections. 

Eclectic 

The Eclectic column shows the minimum times for each section and totals them to show the 
best possible time if all sections could be completed in the minimum times. This can be a bit 
unrealistic as driving line etc. can affect the times from one section to the next so the 
minimum times can’t be joined up in practice. 

Rolling Minimum 

The rolling minimum shows the set of consecutive section times that form the minimum 
overall time for a complete lap. These times are highlighted in bold to easily determine 
where this starts, i.e. it will typically be spread across 2 laps. 

Sections 

To change the sections used, go to the Time Report properties (F5) then ‘Data – Ranges – 
Report on:’ and select the section type – Defaults, User Defined or Splits (if available). 

Press the ‘0’ key, or choose section times to select the section times report. 
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Similar to channel statistics, i2 can create reports based on time around the track, called a 
‘Time Report’. These time reports are used to further examine the detail about where you 
were fast and where you were slow, section by section across the whole lap.  

You can report on: 

• All sections 

• Corner sections only 

• Straights sections only 

• Custom sections only 

• Split beacon sections 

You can create a report such as the one in the top right corner which shows times for the 4 
lap outing, only when the car was going around corners as shown by the section markers on 
the track. The red line indicates the rolling minimum lap time. The rolling minimum is the 
fastest lap that the car did for that outing regardless of where the Start/Finish line is. It may 
start and finish on the back straight, instead of at the start finish line. It is good indication of 
a lap that the car is capable of doing, as it was actually driven, but can be affected by an 
artificially fast section, such as forgetting to brake at all for a corner. Check adjacent section 
times to see if it is a realistic time. 
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Different shades of colour can be used to indicate how close the driver is to the minimum 
time in terms of percentage. The lower the percentage, the closer the time is to their 
minimum and therefore the more consistent the driver is in those track sections.  
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Under braking the kinetic energy is turned into heat and light in the brake rotor. This energy 
can be detected using an Infrared sensor. These type of sensors are also used to measure 
tyre temperature. 
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From the brake pad manufacturer – know the temperature range within the braking system 
when it is operating at its peak performance. From the data we can see if we are achieving 
the desired temperatures. Then decide what we need to do with brake ducts. 
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Notice the increasing brake temperatures over a race distance and the stabilization of 
temperatures over a number of laps. 
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Linear potentiometer (resistive sensing element) or a linear pot. There is a slider that moves 
along a track and the resistance changes. Useful sensors but fragile and need to be 
maintained. 
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Click on Workbook list, and select ‘Seminar’, select new Worksheet, calling it ‘Suspension’. 

Right click on Worksheet space, and select ‘Add’ then ‘Time Distance Graph’. 

From the next panel, select ‘Add channel’, then add the channels shown above. 
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Observe what is happening on the straights and corners. Convention is to have negative 
suspension travel as compression. 
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Firstly, it is important to observe the raw data because this could already highlight some car 
setup problems, or sensor installation/wiring problems. 

Moreover, you may see differences between vibrations in compression and in rebound. Raw 
data from shocks or strain gauges could be difficult to understand in terms of noticeable car 
attitude change, especially without zooming in. A filtered signal allows overall trends to be 
seen without any zoom needed. However, it is important to have a look at them first without 
applying any filter to be sure that you do not miss a part of the behaviour. 

In the same way, it’s important to also consider that the size of your screen also acts like a 
filter.  

For example, say that your computer resolution is 1024 x 768 and you are looking at data 
logged at 20Hz. At the best you will see only 1024 / 20 = 51.2 seconds of the data without 
any filtering. So if you look at an entire lap that is longer than this you are necessarily 
‘filtering’ – not all of the data points will fit onto the screen. If you want to see the each 
point, you need to zoom onto a segment equal to or smaller than 51.2 seconds. 

Changing the display to show ‘Points’ rather than lines will quickly tell you if you are seeing 
all of the data or not. 
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Damper settings represent an interesting part of fine tuning a racecar. Even if the basic 
principles are simple, without any tools it is almost impossible for the engineer to know if the 
dampers are really working at their best. 

With four linear potentiometers on the car you can record where, when, and how each 
damper applies forces to the car. 

The damper speed histogram is a simple tool allowing us to check how the dampers are 
working. It refines the ratio between low and high speed, as well as bump and rebound, 
front and rear, left and right. It is also very useful for checking that your dampers have been 
set up correctly. 

The damper speed histogram shows the percentage of time (out of the lap time) that the 
shock is spending at certain speeds. 

The damper histogram is made up of four parts. Low speed bump, Low speed rebound, High 
speed bump and High speed rebound. A damper should always spend more of its time 
around the change of direction (0mm/s) than any other point on the histogram. It should 
spend progressively less and less as the graph goes from low speed to high speed. The 
change over point from low to high speed is vehicle and damper dependant but on a circuit 
racing vehicle often around 25mm per second. A balanced histogram should show a 
symmetrical curve. If you want a damper to spend more time in one point on the histogram, 
you need to stiffen up the damper in that region. To spend less time there, you need to 
soften the damper in that area. 
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By simple observation we can see that the 2 front dampers shown in the top left histogram 
do not seem evenly balanced. A good shock histogram should show a symmetrical curve. If 
we take the values displayed at the top of the histogram we can observe the percentage of 
time spent in low or high speed bump or rebound.  

When the histograms are compared to each other, we look at Low speed bump to Low 
speed rebound, then High speed bump versus High speed rebound. We can deduce from the 
above histogram of the front left damper that the low speed bump setting is too stiff, as it is 
spending too much time there compared to the low speed rebound. So to fix this we would 
soften the left low speed bump settings, and in this example we softened it just one click.  

Looking at the front right damper, we can see that it is far more uneven. It is spending 34% 
of time in low speed bump, with only 27% in low speed rebound. To even this out, we would 
soften the right front low speed bump settings. That would increase the time spent in high 
speed bump, giving a far more even damper histogram distribution. 

In this actual example, the car gained 3/10ths of a second after making this change to the 
damper settings. 
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The suspension histogram component displays histograms for a number of suspension velocity 
channels. The velocity channels are normally calculated from suspension or damper position channels. 
i2 includes built in velocity calculations. The calculations can be configured from the ‘Velocity 
Calculation’ page in the ‘Suspension Histogram’ properties. If needed these calculations can be turned 
off and the user can create their own maths functions to generate the velocity channels. 

Filter 

The velocity calculation includes filtering of the position channels to ensure good results when 
plotting the histogram. Without an appropriate amount of filtering the histograms may look "notchy". 
Note that too much filtering will reduce the high frequency content of the signal so too much filtering 
is also undesirable. 

Style 

The histogram can be displayed as either a line graph or a bar graph.  The channels can also be 
overlapped or displayed in a grid of panels. The bar style looks more like a conventional histogram 
however the line style is much more useful when comparing one channel to another or when the 
channels are overlapped. 

High Speed/ Low Speed Boundary 

A velocity can be nominated as the Hi Speed/ Lo Speed boundary. This is normally set to match the 
high speed, low speed transition of the damper. This value is used in the various calculated info and is 
shown visually as band on the histogram. 

Calculated Info 

The suspension histograms calculate the following data: 

Rebound Avg: The average velocity of all values of rebound 

Rebound Hi %:  Percentage of velocities falling in the rebound Hi speed area. 

Rebound Lo %:  Percentage of velocities falling in the rebound Lo speed area. 

Bump Avg: The average velocity of all values of bump 

Bump Hi %:  Percentage of velocities falling in the bump Hi speed area. 

Bump Lo %:  Percentage of velocities falling in the bump Lo speed area. 

Note that ‘bump’ velocities can be selected as either positive velocities or negative velocities 
(rebound will be the opposite). 
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Have you ever wondered how valuable the data is that comes from measurements made with a 
tyre temperature probe? Do you want to make critical setup decisions from data that is strongly 
influenced by the length of the pit lane, your position on the pit lane, and the position of the pit 
entry on the track? What happens if the pit entry is just after a heavy lateral G corner? And what 
would the temperature measure if this corner was oriented in another direction?  

Your tyre temperatures, by the time that you get to measure them, are heavily skewed by the 
last thing that happened to the car. If the pitlane entry is long, the tires would have cooled down 
considerably, and the temperatures may have equalised whilst driving down the lane. Perhaps 
due to static camber, you may see very high temperatures on the inside of a tyre in a straight 
line, but the same car may be very good under brakes and through cornering due to the caster 
and camber curves in the suspension design. So you may end up pulling off camber due to the 
high inner temperatures read by a pyrometer in pit lane, where the car may in fact be well set up 
for where it matters, under brakes and through the corners. 

Making setup adjustments based upon data coming from a tyre temperature probe is unlikely to 
work because it is way too imprecise. The solution, as shown above, is to mount 3 infrared tyre 
temp sensors by the wheel, continuously monitoring the evolution, turn after turn, of the tyre 
temperature surface in the middle, the outer and the inner edge of the tire. 

Even if these tyre temperature sensors are only taking the surface temperature of the rubber 
and not the core temperature like the probe, it can be easily demonstrated that the 
temperatures of the tyres measured in the pits are only giving a vague indication of what is really 
happening on the track.  

The measured pyrometer readings in pit lane from the car represented by the data above were: 
Inside 56 Centre 45 Outside 38 

Pyrometers don’t show you where the tyre temperature is coming from, whether it is down the 
straights (too much static camber), in corners (not enough roll on camber or caster), or under 
brakes (too much camber change under bump). Only data logged tyre temperature sensors can 
do that. 
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What Can I Learn From One or Three Tyre Temperature Sensors per Wheel? 

Depending on the budget of the team, it is possible to install either one or three tyre 
temperature sensors per tyre. While it is possible to establish a clearer picture of how one tyre is 
working with three sensors installed across the face of the tyre, a large amount of information 
can be established by installing just one tyre temperature sensor. The following information can 
be obtained if one tyre temperature sensor is installed at the centre of each tyre: 

• Load distribution 

• Brake distribution and balance 
• Wheel lock-up 
• Wheel lift 
• Traction loss/ wheel spin 

• Cornering temperatures 
• General dynamic operating temperature 

• Oversteer and understeer indications 

It is also possible to install three tyre temperature sensors across the face of the tyre to establish 
a clearer picture of how the tyre is working, as shown above. 

The ability to understand temperature information across the face of a tyre will allow the race 
engineer to tune the car more effectively, as well as monitoring the results of each change. As 
well as obtaining the information mentioned above for one tyre temperature sensor, three tyre 
temperature sensors could also acquire the following data: 

• Temperature distribution 
• Tyre inflation (over/under) 
• Camber adjustment (too much/little) 

• Toe (too much/little) 

Therefore, it is possible to conclude that one tyre temperature sensor on each wheel will provide 
us with general information about the chassis and tyre performance. Three temperature sensors 
will allow us to establish a greater understanding of how each tyre on the car is performing, and 
permit individual changes to be made to each wheel allowing for maximum performance. 
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In Dash Manager you can go to file then details editor to setup where the log files should be 
stored when you download the data. Make sure you have folders organised by year and 
venue as well as session if you can, then you will quickly be able to find older data when you 
need to do comparisons. 
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If you forget to update the details in your Dash Manager before a session then you can 
amend the details in i2 to each of your log files.  

The menu item ‘Tool – Details’, or ‘Ctrl + D’ keyboard shortcut will bring up a window with 
details for all the files that are currently open. Groups of detailed information can be 
expanded and collapsed using the +/- symbols on the left of the window. 

Click on the ‘Edit’ button to bring up a ‘Details Editor’ window. Most of the details listed can 
be edited or added if they had been left empty. Details with numerical values such as gear 
and diff ratios can be used in maths expressions. 
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If you fill in the vehicle details you can use these for your maths calculations. 

The short comment shows up when you ‘open’ window for logging files but long comment is 
not shown. 
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If you want to process your data using methods not available in i2, or perhaps you want to send 
someone part, but not all of your data, there is an export facility in i2. Export allows you to save 
your data in one of three formats: either CSV (Comma delimited text file) suitable for Microsoft 
Excel or other non MoTeC applications, the Matlab data format (i2 Pro), or the MoTeC log file 
format, which will let you open the new file in i2 again.  

The File menu has an item called ‘Export’. This will always export all of the channels in your file to 
another log file or a CSV file. Often people wish to export a subset of data, this is done by 
creating a graph with just those channels that you wish to export shown. Then right-click on the 
graph and select ‘Export Data’, only those channels on this graph will be exported. 

Both functions allow you to select the timeframe over which to export data: Entire outing (the 
whole log file), Current Range (e.g. a lap), Visible Data - just the time/distance range shown on 
screen, e.g. after zooming in. 

Data Export: All data or a portion (e.g. lap) may be exported. To export data to a MoTeC (.ld) file, 
CSV format file or .MAT Matlab file, on the Graph Component menu, click Export Data. 

NOTE: Only the channels in the graph will be exported. 

CSV Files: CSV stands for Comma Separated Value file. This is a common format that can be 
imported by many applications including spread sheet programs such as MS Excel. 

MoTeC Log Files: Exporting to a MoTeC log file allows a small number of channels to be 
exported. This can be useful when you need to give someone some of your data but not all of it. 

The device configuration can be included or excluded from the exported data. 

The various details can also be included or excluded. 

NOTE: When exporting the Current Range (Lap), we export slightly more data then the lap, to 
ensure the beacons are correctly positioned. This will result in a very small in and out lap. 

MATLAB Files: All channels may be exported to a .MAT file. The .MAT file can be loaded into 
MATLAB and used in the usual way. The output sample rate may be specified as follows: 

• Default: each channel is exported at it own rate.  

• Fastest: All channels are up-sampled to the fastest channel rate.  

• Custom: All channels are re-sampled to the specified rate.  
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It is also useful to then store the outing stats using the ‘export to clipboard’ function to 
create an ongoing spreadsheet of races and sessions. Right clicking in the Channel Report 
area will give you two options. Left click on To File if you want a .csv file or Left Click on To 
Clipboard if you want to paste the data into a spreadsheet.  
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Here is a sample of a race summary sheet. You can see that it lists summary information of 
selected channels from each session of an event, and the tabs at the bottom show the other 
events of the year. The file is created by exporting out information from the Channel Report 
screen and pasting it into a spreadsheet. This gives you a useful, ongoing record of important 
pieces of information about your vehicle. It can be used to bring attention to trends in your 
data of changes in oil pressure, battery voltage, diff temps, gearbox temps, whatever is 
useful to measure for your particular vehicle. With this data, when you ask, “Is it normal for 
the gearbox to run at that temperature? At this track?”, you can quickly go over previous 
sessions, races, and years to see what you should expect from your vehicle. Using the i2 
channel reports to create these summary sheets can help increase the reliability of your 
racing. 

Note that it is very helpful to record information such as ambient air temperature and track 
temperature with your details and then include them with the summary spreadsheet. 
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With the aid of a radio device the Dash/Logger can send back live telemetry data to a 
computer back in the pits where a T2 Server application can decrypt the stream and 
rebroadcast on a network for multiple i2 Pro versions of software to receive. 

T2 Server is capable of recording the incoming telemetry stream, for replay at a later time. 
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Dash Manager Setup  

Communications Setup  

Note: The T2 function upgrade must be enabled for the Data Logger to send telemetry data.  

Current RS232 communication templates Telemetry Only or GPS & Telemetry can be used 
with T2.  

Setup communications:  

Go to the Connections > Communications menu.  

In the Communicators Setup window, select an RS232 tab.  

Set the applicable baud rate for the selected RS232 port.  

Once the communications are set up, click on and open the telemetry setup. Here is where 
you define the T2 Telemetry option, what channels and at what rates they will be sent. 

If receiving telemetry from multiple cars with different names, alias names can be used to 
make all incoming channels appear with the same name. This is more so used in category 
wide applications. 
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Adding inputs to receive the data telemetry source and defining outputs for where to send 
the data. 
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MetaData File 

When a Data Manager Logger configuration file including T2 Telemetry setup is sent to the 
Data Logger, a Metadata file is created. This file is essential for T2 to operate it defines the 
channel names, and units. 

Note: When Dash Manger and T2 Server are running on the same PC, and using the default 
location for the Metadata file, no intervention is required and access to the file is automatic. 

MetaData Location 

Dash Manager 

By default, the Metadata file is saved in the C:\ProgramData\MoTeC\T2\MetaData folder of 
the Dash Manager PC. 

To specify a different location: in Dash Manager Tools > Options menu Telemetry tab, 
specify the required location. 

T2 Server 

To receive and transmit telemetry data, the T2 server requires the Metadata file to be 
located in the C:\ProgramData\MoTeC\T2\MetaData folder on the PC that runs T2 Server.  

T2 Server can be set up to automatically pull and copy the file to this location as follows: 

In T2 Server, go to the Tools > Options menu Folders tab and specify the remote location for 
T2 Server to search. 

Select the Add button to specify other locations. 

As each Metadata file has a unique identifier, T2 server monitors all specified locations and 
pulls the Metadata file once it is available. 
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To record the incoming data stream the tick box ‘Save input data’ needs to be ticked. 

A Network or Serial port allows for a physical port to be configured to receive the stream, A 
MoTeC LD or MoTeC Image file allow pre-recorded or logged files to be replayed. 

A T2 Server allows for a connection from another T2 server distributing the stream. 
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T2 Server can have muliple outputs for the single incoming stream. 

These outputs can be setup with different encryption, filters and or sent to different 
networks. 

Data can be sent to ‘All interfaces’  this will send data to all network connections. 

‘Loopback Interface’ will only distribute on the local machine. 

Otherwise you can select a specific network to send the data. 
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Telemetry: The Telemetry window is used to add, edit and manage telemetry sources.  

Add: Displays the Select Telemetry Sources window, from where available telemetry sources 
a can be selected and added to the Telemetry window. 

Remove: Removes the highlighted telemetry source from the Telemetry window. 

Edit: Displays the Edit Telemetry Source window, from where the source details can be 
adjusted. 

Split: Split data into a logged source and telemetry source. 

Status: Display the status of the telemetry source. 

Retrieve: Retrieve logged data for the telemetry source from the telemetry server. 

Security: Manage telemetry source passwords. 
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Math Channels  

In telemetry mode, Math Channels can calculate their values live. To do this, in the Math 
Expressions Editor, select the Apply to: Telemetry checkbox.  
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If a channel has been sent over telemetry with an Allais name configured, to use this name in 
the i2 as the name of the channel  Click on Tools | Options from the i2 menu, 

In the Options box, Click on the Telemetry Tab and Tick on the option ‘Use alternative names 
& units’. If the Use alternative names and units boxes are not ticked in either T2 or i2Pro the 
standard channel name will be used. 

Telemetry Tab 

 Zoom Properties  Window Types 

Sliding: The cursor stays at the right edge of the graph and as the data comes in the window 
is continuously slides to the right . The size of the window is defined by Window Duration in 
seconds for time mode and in metres for distance mode. 

Anchored: When anchored mode is selected the window is static and for the defined 
duration time/distance. The window is divided into two parts: historic data (with user 
definable duration) and live data. When live data is received, the cursor moves inside the live 
data part until it reaches right edge of the window, at which point the window jumps to the 
left and the live data becomes the new historic data. The new live data continues to be 
drawn in the new live data part. 

Anchored Lap (Distance Mode) - Anchored Lap Type is valid only for distance mode and uses 
lap distance as the Window Duration and margin to show historic data. 

Invalidate dropped samples: When this check box is unchecked, channels hold the last valid 
value when samples are dropped. 

Invalidate dropouts longer than: When this check box is checked, channel values are 
invalidated if the samples were dropped for longer than the user defined duration. 

Meta Data Folder: The folder where telemetry MetaData file is saved. 

Data Cache Folder: The folder where telemetry data is cached. 

Limit each telemetry source disk usage. 

When this check box is checked, the cache will grow until it reaches the user defined size. 
After that the cache memory is overwritten from the start of the data. 
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i2 features an all new auto run insert function. With a few clicks of the mouse button the 
software can automatically insert the pass into the data with all relevant incremental times 
shown. 

Once set up, all your runs will start from exactly the same moment in each file, triggered 
from an event that occurs on the vehicle. This can be the first pulse from the drive shaft 
speed sensor or a signal from an on off switch such as a Wide Open Throttle switch. It is best 
to choose an event that indicates the actual forward movement of the vehicle. Testing 
suggests this is around the point where data shows a Longitudinal G force greater than 0.2g 

The default method is to use the point where ‘Drive Shaft Speed’ starts to move. Though this 
can be changed to another channel. 
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Once the start point of the run has been determined, we can enter information from the 
timeslip into i2, that will also be shown on the graph. 

Go into the ‘Tools’ menu and choose the ‘Run Editor’. From here choose ‘Edit Details’, and 
enter the time slip information into the cells. At the completion of entering the time slip 
information press OK.  

In here you can also store other important details about the run, such as the weather at the 
time of the run, tyre temps, pressures, gearing etc. so that later you can go back and see 
what contributed to a better or worse run that time. 

This will return you to the ‘create run’ screen where all that remains is to click ‘create’ and 
the run will be highlighted in the data. To select the run press W for ‘whole run’. 
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Back in the data, the exact run is then displayed along with 1 second of data pre and post run 
with a grey background. Also displayed is the entered time sheet information, i.e. 
60/330/1000 ft times. 

In the example above, the blue corrected speed line on the bottom group shows the 
corrected speed and therefore distance travelled. This becomes particularly important for 
overlaying other files and reading Time and Distance reports. 
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If there is already a run on screen and it is not in the right place you can easily shift it by 
using the Create Run at Cursor feature. 

In the above example the run has been previously auto created using the first drive shaft 
speed data point. Depending on the number of teeth on the drive shaft this point can be a 
long time after the car has actually started to move. 

In the above picture we have changed the properties of the time/distance graph to show 
data points rather than lines. After some limited testing we have made a rough conclusion 
that most cars actually start to cross the beam somewhere around 0.25 G Longitudinal. The 
cursor (blue line) has been placed at this point and now by clicking the ‘Create Run at Cursor’ 
icon (Hot Key: Shift + F7) the run start point will be corrected. Assuming all increments are 
the same, click the create button and the run will shift to this point. 
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Gating : The gating channel allows data to be rejected based on the value of a channel. Data 
is rejected if the channel value is less than or equal to zero. The gating channel is normally 
generated by a maths expression. For example a maths channel defined as abs(‘G Force Lat’) 
> 0.5 would result in a value of 1 during corners and 0 during straights and would therefore 
reject any data in straights. Gating can be used with Scatter Plots, Mixture Maps, Histograms 
and Suspension Histograms, with the same or a different gating expression for each. This is 
similar to how you can turn on and off trace colors in a histogram. 

User Sections: In addition to modifying the auto created sections, users can define a new 
section category and define sections from scratch, e.g. track sectors. These can then be used 
in channel reports, track reports and time reports. 

Alias Editor: allows a channel to be created that will use the data from the first available 
channel in the corresponding alias list. This can be useful if the name of a channel varies 
between log files. For example an alias channel could be created called Vehicle Speed that 
uses either Ground Speed,  Wheel Speed FL or Wheel Speed FR.  Note that the first available 
channel is used so the order of the list can be important. 

Channel Mapping: allows a channel to be renamed and/or the units of a channel to be 
overridden. This can be useful if a channel is named differently in some log files. It is also 
useful for channels that were logged without units (for example a Wheel Speed from an 
ECU). 
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Setup Sheets 

Allows the user to import a list of values relevant to a particular session, e.g. Corner weights, Spring Rates, 
Tyre pressures. As well as being linked to the relevant log file, the data can be used in maths expressions. 

Setup Sheets are a method by which users are able to track changes to their car, along with making these 
changes available to be used as a constants within i2 for Maths calculations. It can be thought of as a 
flexible extension to the details editor area per car and session. The sheet is built and pre formatted by i2, 
and there is one created per car id. In your log file details, you specify an ID for your vehicle. This id must be 
unique to that vehicle, as this is used for the name of the setup sheet. To start a setup sheet, click on the 
“Create” button, which then becomes the “Edit” button. This creates the setup sheet named {Vehicleid}.xls, 
and opens it for editing.  

The sheet, once created, is relatively free format, you can change or add any channel name, it just needs to 
start in column A. You can choose from any of the available channel units that i2 recognises for your 
channel, if there are no suitable units, leave it blank and it will come across as unitless. Next, add the 
time/date stamp for your data. To decide which constant is suitable for the currently selected log file, i2 
looks at the download time of the log file, and finds the last column that the log file was created after. If 
there is a value in that row, it takes that value. If it is blank, then it goes back one column at a time until it 
finds a value, which it uses as the value for that channel. So you can see in the above example, that the file 
date of 23/11/2005 would make it use the column ’E’. Here it chooses the ‘Wheelbase’ of 2010, 
‘Wheelbase Left’ of 2010, but has to go back to column ‘D’ to find a value for ‘Wheelbase Right’[, at 
2005mm. 

There are a few more things to note about setup sheets. If two blank cells are seen in a row in column A 
(after row 10), it is deemed that there are no more channels to process.  

There is one sheet per vehicle ID per project, so be sure to use the same project each time. You can use 
formulas to create values in the cells; only the final result is used within i2. 

If you have further calculations to do for your formula, do them on another sheet, as it only looks at the 
first sheet of the Workbook when looking for the setup sheet. 

To view the setup sheet, click on the ‘Tools’ menu, then ‘Setup Sheets’, or Control+T 

If there is a button called create, click that to create a sheet, or use Edit if it already exists 

Add some numbers into cells C11, C12, C13 and C14 

Save and close the spreadsheet. 
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